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This chapter includes: 
• Electrical Safety ................................................................................................................................................................ 10 
• Operational Safety .......................................................................................................................................................... 12 
• Maintenance Safety ....................................................................................................................................................... 14 
• Printer Symbols ................................................................................................................................................................. 15 
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Your printer and the recommended supplies have been designed and tested to meet strict safety 
requirements. Attention to the following information ensures the continued safe operation of your Xerox 
printer. 
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Electrical Safety 

This section includes: 
• General Guidelines ........................................................................................................................................................... 10 
• Power Cord ......................................................................................................................................................................... 10 
• Emergency Turn Off ........................................................................................................................................................ 11 
• Laser Safety ........................................................................................................................................................................ 11 
 
 

General Guidelines 
 

 WARNINGS:  

• Do not push objects into slots or openings on the printer. Touching a voltage point or shorting 
out a part could result in fire or electric shock. 

• Do not remove the covers or guards that are fastened with screws unless you are installing 
optional equipment and are instructed to do so. Turn off the printer when performing these 
installations. Disconnect the power cord when removing covers and guards for installing optional 
equipment. Except for user-installable options, there are no parts that you can maintain or 
service behind these covers. 

 

The following are hazards to your safety: 
• The power cord is damaged or frayed. 
• Liquid is spilled into the printer. 
• The printer is exposed to water. 
• The printer emits smoke, or the surface is unusually hot. 
• The printer emits unusual noise or odors. 
• The printer causes a circuit breaker, fuse, or other safety device to activate. 

If any of these conditions occur, do the following: 
1. Turn off the printer immediately. 
2. Disconnect the power cord from the electrical outlet. 
3. Call an authorized service representative. 
 

Power Cord 
• Use the power cord supplied with your printer. 
• Plug the power cord directly into a properly grounded electrical outlet. Ensure that each end of the 

cord is connected securely. If you do not know if an outlet is grounded, ask an electrician to check 
the outlet. 
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• Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have a 
ground connection terminal. 

 

 WARNING: Avoid the potential of electrical shock by ensuring that the printer is grounded properly. 
Electrical products can be hazardous if misused. 

 

• Only use an extension cord or power strip designed to handle the electrical current capacity of the 
printer. 

• Verify that the printer is plugged into an outlet that is providing the correct voltage and power. 
Review the electrical specification of the printer with an electrician if necessary. 

• Do not place the printer in an area where people can step on the power cord. 
• Do not place objects on the power cord. 
• Do not plug or unplug the power cord while the power switch is in the On position. 
• If the power cord becomes frayed or worn, replace it. 
• To avoid electrical shock and damage to the cord, grasp the plug when unplugging the power cord. 

The power cord is attached to the printer as a plug-in device on the back of the printer. If it is necessary 
to disconnect all electrical power from the printer, disconnect the power cord from the electrical outlet. 
 

Emergency Turn Off 

If any of the following conditions occur, turn off the printer immediately and disconnect the power cord 
from the electrical outlet. Contact an authorized Xerox service representative to correct the problem if: 
• The equipment emits unusual odors or makes unusual noises. 
• The power cable is damaged or frayed. 
• A wall panel circuit breaker, fuse, or other safety device has been tripped. 
• Liquid is spilled into the printer. 
• The printer is exposed to water. 
• Any part of the printer is damaged. 
 

Laser Safety 

This printer complies with laser product performance standards set by governmental, national, and 
international agencies and is certified as a Class 1 Laser Product. The printer does not emit hazardous 
light because the beam is totally enclosed during all modes of customer operation and maintenance. 
 

 WARNING: Use of controls, adjustments, or performance of procedures other than those specified in 
this manual can result in hazardous radiation exposure. 
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Operational Safety 

Your printer and supplies were designed and tested to meet strict safety requirements. These include 
safety agency examination, approval, and compliance with established environmental standards. 

Your attention to the following safety guidelines helps to ensure the continued, safe operation of your 
printer. 
 

Operational Guidelines 
• Do not remove any paper trays while the printer is printing. 
• Do not open the doors when the printer is printing. 
• Do not move the printer when it is printing. 
• Keep hands, hair, neckties, and so on, away from the exit and feed rollers. 
• Covers, which require tools for removal, protect the hazard areas within the printer. Do not remove 

the protective covers. 
 

Ozone Release 

This printer produces ozone during normal operation. The amount of ozone produced is dependent on 
copy volume. Ozone is heavier than air and is not produced in amounts large enough to harm anyone. 
Install the printer in a well-ventilated room. 

For more information in the United States and Canada, go to www.xerox.com/environment. In other 
markets, please contact your local Xerox representative or go to www.xerox.com/environment_europe. 
 

Printer Location 
• Place the printer on a level, solid, non-vibrating surface with adequate strength to hold its weight. 

To find the weight for your printer configuration, see Physical Specifications on page 126. 
• Do not block or cover the slots or openings on the printer. These openings are provided for 

ventilation and to prevent overheating of the printer. 
• Place the printer in an area where there is adequate space for operation and servicing. 
• Place the printer in a dust-free area. 
• Do not store or operate the printer in an extremely hot, cold, or humid environment. 
• Do not place the printer near a heat source. 
• Do not place the printer in direct sunlight to avoid exposure to light-sensitive components. 
• Do not place the printer where it is directly exposed to the cold air flow from an air conditioning 

system. 
• Do not place the printer in locations susceptible to vibrations. 
• For optimum performance, use the printer at the elevations specified in Elevation on page 129. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3610&PgName=environmentna&Language=English�
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3610&PgName=environmenteu&Language=English�
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Printer Supplies 
• Use the supplies designed for your printer. The use of unsuitable materials can cause poor 

performance and a possible safety hazard. 
• Follow all warnings and instructions marked on, or supplied with, the product, options, and supplies. 
• Store all consumables in accordance with the instructions given on the package or container. 
• Keep all consumables away from the reach of children. 
• Never throw toner, print/drum cartridges, or toner containers into an open flame. 
• When handling cartridges, for example toner and such, avoid skin or eye contact. Eye contact can 

cause irritation and inflammation. Do not attempt to disassemble the cartridge, which can increase 
the risk of skin or eye contact. 

 

 CAUTION: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service Agreement, 
and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of performance 
caused by use of non-Xerox supplies, or the use of Xerox supplies not specified for this printer. The 
Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary 
outside these areas. Please contact your Xerox representative for details. 
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Maintenance Safety 

• Do not attempt any maintenance procedure that is not specifically described in the documentation 
supplied with your printer. 

• Do not use aerosol cleaners. Clean with a dry lint-free cloth only. 
• Do not burn any consumables or routine maintenance items. For information on Xerox supplies 

recycling programs, go to www.xerox.com/gwa. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3610&PgName=recyclesupplies&Language=English�
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Printer Symbols 

Symbol Description 

 

Warning: 
Indicates a hazard which, if not avoided, could result in death or serious injury. 

 

Caution: 
Indicates a mandatory action to take in order to avoid damage to the property. 

 

Hot surface on or in the printer. Use caution to avoid personal injury. 

 

Do not burn the item. 

 

Do not expose the imaging unit to light for more than 10 minutes. 

 

Do not expose the imaging unit to direct sunlight. 

 

Do not touch the part or area of the printer. 

 

 

Warning: 
Wait for the printer to cool for the specified time before touching the fuser. 

 

This item can be recycled. For details, see Recycling and Disposal on page 139. 
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Environmental, Health, and Safety Contact 
Information 

For more information on Environment, Health, and Safety in relation to this Xerox product and supplies, 
contact the following customer help lines: 

United States: 1-800 828-6571 

Canada: 1-800 828-6571 

Europe: +44 1707 353 434 

For product safety information in the United States, go to www.xerox.com/environment. 

For product safety information in Europe, go to www.xerox.com/environment_europe. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3610&PgName=environmentna&Language=English�
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3610&PgName=environmenteu&Language=English�
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Parts of the Printer 

This section includes: 
• Front View ........................................................................................................................................................................... 18 
• Rear View ............................................................................................................................................................................ 19 
• Internal Parts ..................................................................................................................................................................... 19 
• Control Panel ..................................................................................................................................................................... 20 
 
 

Front View 

 
 

1. Tray 2 (optional) 
2. Tray 1 

3. Bypass Tray 
4. Control Panel 
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Rear View 

 
 

1. Duplex Unit 
2. Transfer Roller 
3. Fuser 
4. Power Connector 
5. Rear Cover 
6. Control Board 

7. Left Side Door 
8. Power Switch 
9. Ethernet Connector 
10. USB Port 
11. Wireless Network Adapter Port 

 
 

Internal Parts 

 
 

1. Front Door Handle 
2. Output Tray Paper Stop 
3. Front Door 

4. Smart Kit Drum Cartridge 
5. Toner Cartridge 
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Control Panel 

The control panel consists of a display, indicator lights, and buttons you press to control the functions 
available on the printer. The control panel: 
• Displays the current operating status of the printer. 
• Provides access to print features. 
• Provides access to reference materials. 
• Provides access to administrative and maintenance menus. 
• Prompts you to load paper, replace supplies, and clear jams. 
• Displays errors and warnings. 

 
1. Back/Return: Moves up one level in the menu. 
2. OK: Displays the selected menu or selects the current menu option. 
3. Menu: Displays the Information Pages, Billing Meters, Admin, Tray Settings, and Panel Language 

menus. 
4. Power Saver: Enters and exits low-power mode. 
5. The control panel display provides information about settings, statuses, and error messages. An 

asterisk (*) next to a menu option indicates the current default setting. 
6. Up and Down arrows: Navigates to the next menu, item, or option. 
7. Left and Right arrows: Moves forward and backward through submenus or number fields. To display 

the Walk-up Features menu and to list Secure Jobs and Saved Jobs, press the Left arrow button. 
8. Cancel: Ends the active print job. 
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9. Error Indicator 
− Lights red to indicate an error condition or warning that requires your attention. 
− Blinks red when an error occurs that requires technical support. 

10. Ready Indicator 
− Lights green when the printer is ready to receive data. 
− Blinks green when the printer is busy receiving data. 
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Energy Saver Mode 

You can set the time the printer spends idle in ready mode before the printer transitions to a lower 
power level. 
 

Exiting Energy Saver Mode 

The printer automatically cancels Energy Saver mode when it receives data from a connected computer. 

To exit Energy Saver mode manually, press the Power Saver button on the control panel. 
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Information Pages 

Your printer has a printable set of information pages. These include configuration and font information, 
demonstration pages, and more. 
 

Configuration Report 

The Configuration Report lists printer information such as default settings, installed options, network 
settings including IP address, and font settings. Use the information on this page to help you configure 
network settings for your printer, and to view page counts and system settings. 
 

Printing a Configuration Report 
1. At the printer control panel, press the Menu button. 

Note: To navigate through the menu, use the Up or Down arrow buttons. 

2. Navigate to Information Pages, then press OK. 
3. Navigate to Configuration, then press OK. 
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Administrative Features 

Finding the IP Address of the Printer 

You can view the IP address of your printer on the Configuration Report. IPv4 and IPv6 address 
information is located in the Network Setup section of the Configuration Report under IPv4 and IPv6. 
 

CentreWare Internet Services 

CentreWare Internet Services is the administration and configuration software installed on the 
embedded Web server in the printer. It allows you to configure and administer the printer from a Web 
browser. 

CentreWare Internet Services requires: 
• A TCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux 

environments. 
• TCP/IP and HTTP enabled on the printer. 
• A network-connected computer with a Web browser. 
 

Accessing CentreWare Internet Services 

At your computer, open a Web browser, in the address field, type the IP address of the printer, then press 
Enter or Return. 
 

Accessing the Printer 

To ensure that unauthorized users cannot access the printer, the system administrator can configure 
authentication and authorization. If the administrator configures authentication and authorization, you 
can be required to log in to access some or all of the features of the printer. 
 

Logging In 

Logging in is the process by which you identify yourself to the printer for authentication. If 
authentication is set, to access printer features, you log in with your user credentials. 
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Logging In to CentreWare Internet Services 

When Administrator Mode is enabled, the Jobs, Address Book, Properties, and Support tabs are locked 
until you enter the administrator user name and password. 

To log in to CentreWare Internet Services as the administrator: 
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then 

press Enter or Return. 
 

Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on 
page 24. 

 

2. Click the Jobs, Address Book, Properties, or Support tab. 
3. Type the administrator user name. 
4. Type your password, then click Login. 
 

Logging In at the Control Panel 
1. To enter numbers on the control panel, select an option: 

− To select a number, press the Up or Down arrow buttons. 
− To scroll quickly, hold down the Up or Down arrow buttons. 
− To move to the next number field, press the Right arrow button. 
− To move to the previous number field, press the Left arrow button. 

2. When finished, press OK. 
 

Billing Meter 

The Billing Meters menu shows the number of processed print jobs. You cannot reset the meter readings; 
they track the total number of pages printed for the life of the printer. 

To view the Billing Meter on the control panel: 
1. At the printer control panel, press the Menu button. 

Note: To navigate through the menu, use the Up or Down arrow buttons. 

2. Navigate to Billing Meters, then press OK. 
3. To select a billing meter, use the Up or Down arrow buttons. 
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More Information 

You can obtain more information about your printer from these sources: 
 

Resource Location 

Installation Guide Packaged with the printer. 

Other documentation for your printer www.xerox.com/office/3610docs  

System Administrator Guide www.xerox.com/office/WC3615docs  

Recommended Media List United States: www.xerox.com/paper  
European Union: www.xerox.com/europaper  

Technical support information for your printer; 
including online technical support, Online Support 
Assistant, and driver downloads. 

www.xerox.com/office/3610support  

Information Pages Print from the control panel, or from CentreWare 
Internet Services, click Status > Information Pages. 

CentreWare Internet Services documentation In CentreWare Internet Services, click Help. 

Order supplies for your printer www.xerox.com/office/3610supplies  

A resource for tools and information, including 
interactive tutorials, printing templates, helpful tips, 
and customized features to meet your individual 
needs. 

www.xerox.com/office/businessresourcecenter  

Local sales and support center www.xerox.com/office/worldcontacts  

Printer registration www.xerox.com/office/register  

Xerox® Direct online store www.direct.xerox.com/  
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This chapter includes: 
• Installation and Setup Overview ................................................................................................................................ 28 
• Selecting a Location for the Printer........................................................................................................................... 29 
• Connecting the Printer ................................................................................................................................................... 30 
• Configuring Network Settings ..................................................................................................................................... 34 
• Configuring General Setup Using CentreWare Internet Services .................................................................. 35 
• Configuring General Setup Using the Control Panel .......................................................................................... 38 
• Installing the Software .................................................................................................................................................. 39 
 

See also:  
Installation Guide packaged with your printer. 
Online Support Assistant at www.xerox.com/office/3610support  
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Installation and Setup Overview 

Before printing, your computer and the printer must be plugged in, turned on, and connected. Configure 
the initial settings of the printer, then install the driver software and utilities on your computer. 

You can connect to your printer directly from your computer using USB, or connect over a network using 
an Ethernet cable or wireless connection. Hardware and cabling requirements vary for the different 
connection methods. Routers, network hubs, network switches, modems, Ethernet cables, and USB cables 
are not included with your printer and must be purchased separately. Xerox recommends an Ethernet 
connection because it is typically faster than a USB connection, and it provides access to CentreWare 
Internet Services. 

For details, see the System Administrator Guide at www.xerox.com/office/WC3615docs. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC3615&PgName=Man&Language=English�
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Selecting a Location for the Printer 

1. Select a dust-free area with temperatures from 10–32°C (50–90°F), and relative humidity 15–85%. 
 

Note: Sudden temperature fluctuations can affect print quality. Rapid heating of a cold room can 
cause condensation inside the printer, directly interfering with image transfer. 

 

2. Place the printer on a level, solid, non-vibrating surface with adequate strength for the weight of the 
printer. The printer must be horizontal with all four feet in solid contact with the surface. To find the 
weight for your printer configuration, see Physical Specifications on page 126. 

After positioning the printer, you are ready to connect it to the power source and computer or network. 
 

See also:  
Total Space Requirements on page 127 
Clearance Requirements on page 127 
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Connecting the Printer 

This section includes: 
• Selecting a Connection Method ................................................................................................................................. 30 
• Connecting to a Computer Using USB ..................................................................................................................... 30 
• Connecting to a Wired Network ................................................................................................................................. 31 
• Finding the IP Address of the Printer Using the Control Panel ....................................................................... 31 
• Connecting to a Wireless Network ............................................................................................................................ 32 
 
 

Selecting a Connection Method 

The printer can be connected to your computer using a USB cable or an Ethernet cable. The method you 
select depends on how your computer is connected to the network. A USB connection is a direct 
connection and is the easiest to set up. An Ethernet connection is used for networking. If you are using a 
network connection, it is important to understand how your computer is connected to the network. For 
details, see About TCP/IP and IP Addresses on page 34. 

Note: Hardware and cabling requirements vary for the different connection methods. Routers, 
network hubs, network switches, modems, Ethernet cables, and USB cables are not included with 
your printer and must be purchased separately. 

• Network: If your computer is connected to an office network or home network, use an Ethernet 
cable to connect the printer to the network. You cannot connect the printer directly to the computer. 
It must be connected through a router or hub. An Ethernet network can be used for one or more 
computers and supports many printers and systems simultaneously. Ethernet connection is typically 
faster than USB and allows you direct access to the settings of the printer using CentreWare 
Internet Services. 

• Wireless Network: If your computer includes a wireless router or wireless access point, you can 
connect the printer to the network with a wireless connection. A wireless network connection 
provides the same access and services as a wired connection provides. A wireless network 
connection is typically faster than USB and allows direct access to the setting of the printer using 
CentreWare Internet Services. 

• USB: If you connect the printer to one computer and do not have a network, use a USB connection. 
A USB connection offers fast data speeds, but typically not as fast as an Ethernet connection. In 
addition, a USB connection does not provide access to CentreWare Internet Services. 

 

Connecting to a Computer Using USB 

To use USB, you must have Windows XP SP1 and later, Windows Server 2003 and later, or Macintosh OS 
X version 10.5 and later. 

To connect the printer to the computer using a USB cable: 
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1. Ensure that the printer is turned off. 
2. Connect the B end of a standard A/B USB 2.0 cable to the USB Port on the back of the printer. 
3. Attach the power cord and then plug in the printer and turn it on. 
4. Connect the A end of the USB cable to the USB Port on the computer. 
5. When the Windows Found New Hardware Wizard appears, cancel it. 
6. You are ready to install the print drivers. For details, see Installing the Software on page 39. 
 

Connecting to a Wired Network 
1. Ensure that the printer is turned off. 
2. Using an Ethernet cable, connect the printer to the network. 
3. Attach the power cord to the printer, plug the cord into an electrical outlet, then turn on the printer. 
4. Set or automatically discover the network IP address of the printer. 

For details, see the System Administrator Guide at www.xerox.com/office/WC3615docs. 
 

Finding the IP Address of the Printer Using the Control Panel 

To install the print drivers for a network-connected printer, you need the IP address of your printer. You 
also need the IP address to access the settings of your printer through CentreWare Internet Services. You 
can view the IP address of your printer on the Configuration Page or on the control panel. 

After the printer has been on for two minutes, print the Configuration Page. The TCP/IP address appears 
in the Network section of the page. If the IP address listed on the page is 0.0.0.0, the printer needs more 
time to acquire an IP address from the DHCP server. Wait two minutes, then print the Configuration 
Page again. 

To print the Configuration Page: 
1. At the printer control panel, press the Menu button. 

Note: To navigate through the menu, use the Up or Down arrow buttons. 

2. Navigate to Information Pages, then press OK. 
3. Navigate to Configuration, then press OK. 

The IP address of the printer is listed in the Wired Network section of the page. 

To view the IP address of the printer on the control panel: 
1. At the printer control panel, press the Menu button. 

Note: To navigate through the menu, use the Up or Down arrow buttons. 

2. Navigate to Admin Settings, then press OK. 
3. Navigate to Network Setup, then press OK. 
4. Navigate to TCP/IP, then press OK. 
5. Navigate to IPv4, then press OK. 
6. Navigate to IP Address, then press OK. 

The IP address of the printer appears on the IP Address screen. 
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Connecting to a Wireless Network 

A wireless local area network (WLAN) provides the means to connect two or more devices in a LAN 
without a physical connection. The printer can connect to a wireless LAN that includes a wireless router 
or wireless access point. Before connecting the printer to a wireless network, the wireless router must be 
configured with a service set identifier (SSID), a passphrase, and security protocols. 

Note: Wireless networking is available only on printers with the optional Wireless Network Adapter 
installed. 

 

Installing the Wireless Network Adapter 

The optional wireless network adapter plugs in to the back of the control board. After the adapter is 
installed, and wireless networking is enabled and configured, the adapter is able to connect to a wireless 
network. 

To install the wireless network adapter: 
1. Turn off the printer. 

 
2. Remove the packaging from the wireless network adapter. 
3. To attach the wireless network adapter to the printer, follow the installation sheet provided with the 

wireless network adapter. 

 
Note: Once the wireless network adapter is installed, remove it only as needed and after reading the 
instructions for its removal. 
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4. To enable the wireless network adapter, disconnect the Ethernet cable from the printer. 

Note: Only one network connection can be active. During power on, if a network cable is detected, it 
is enabled and the wireless network adapter is disabled. 

5. Turn on the printer. 
6. In the Admin Menu, configure the Wi-Fi settings. For details, see the System Administrator Guide at 

www.xerox.com/office/WC3615docs. 
 

Removing the Wireless Network Adapter 
1. Turn off the printer. 
2. Unscrew the thumbscrew on the back of the left door, then open the left door. 
3. Locate the plastic latch release on the wireless network adapter that protrudes through the back of 

the chassis. 

 
4. To remove the wireless network adapter, reach into the chassis and push inward, then back on the 

latch release. 
 

 CAUTION: Do not use force to pull on the wireless network adapter. If the latch is released properly, 
the adapter pulls out easily. Pulling on the adapter can damage it. 

 

5. Close the left door, then on the back of the door, screw in the thumbscrew. 
6. Connect the printer to your computer with a USB cable or through the network using an Ethernet 

cable. 
7. Turn on the printer. 
 

Resetting Wireless Settings 

If the printer was previously installed in a wireless network environment, it could retain setup and 
configuration information. 

To prevent the printer from attempting to connect to the previous network, reset the wireless settings. 
For details on resetting or connecting to a wireless network, see the System Administrator guide at 
www.xerox.com/office/WC3615docs. 
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Configuring Network Settings 

This section includes: 
• About TCP/IP and IP Addresses ................................................................................................................................. 34 
 
 

About TCP/IP and IP Addresses 

Computers and printers primarily use TCP/IP protocols to communicate over an Ethernet network. 
Generally, Macintosh computers use either TCP/IP or the Bonjour protocol to communicate with a 
network printer. For Macintosh OS X systems, TCP/IP is preferred. Unlike TCP/IP, however, Bonjour does 
not require printers or computers to have IP addresses. 

With TCP/IP protocols, each printer and computer must have a unique IP address. Many networks and 
cable and DSL routers have a Dynamic Host Configuration Protocol (DHCP) server. A DHCP server 
automatically assigns an IP address to every computer and printer on the network that is configured to 
use DHCP. 

If you use a Cable or DSL router, see the documentation for your router for information on IP addressing. 
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Configuring General Setup Using CentreWare 
Internet Services 

This section includes: 
• Viewing Printer Information ........................................................................................................................................ 35 
• Configuring System Settings ....................................................................................................................................... 36 
• Configuring Clock Settings ........................................................................................................................................... 36 
• Configuring Tray Settings ............................................................................................................................................. 37 

General Setup in CentreWare Internet Services allows you to configure printer settings onscreen using 
your Web browser. 
 
 

Viewing Printer Information 
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In CentreWare Internet Services, click Properties. 
3. To expand the menu, in the Properties pane, next to the General Setup folder, click the plus symbol 

(+). 
4. In the General Setup folder, click About Printer. 
5. Under Version Information, find the printer model number, serial number, and the firmware version 

number for the operating systems. 
6. Under Page Description Language, find the version numbers for each of the page description 

languages installed on the printer. 
7. In the Memory section, find the amount of RAM. If Device Memory is installed, its memory amount 

appears after SD Card. 
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Configuring System Settings 

Use this menu to configure general settings of the printer. For example, time to Energy Saver mode, 
alarm settings, and so on. 

To configure the system settings: 
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In CentreWare Internet Services, click Properties. 
3. To expand the menu, in the Properties pane, next to the General Setup folder, click the plus symbol 

(+). 
4. From the General Setup menu, click System Settings. 
5. Under General, enter values for the Energy Saver modes, then select values for the other selections 

from each of their lists. 
6. Under Timers, for Panel Timeout, select the time from the list. For the Fault Timeout, enter the time 

in seconds. 
7. Under Output Settings, for each of the items, select a value from the list. 
8. Click Save Changes. 
 

Configuring Clock Settings 

Use this menu to set the date and clock settings of the printer. 

To configure the clock settings: 
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In CentreWare Internet Services, click Properties. 
3. To expand the menu, in the Properties pane, next to the General Setup folder, click the plus symbol 

(+). 
4. From the General Setup menu, click Clock Settings. 
5. Next to Date Format, Time Format, and Time Zone, select the setting for each from the 

corresponding list. 
6. Using the selected format, next to Set Date, enter the date. 
7. Using the selected format, next to Set Time, enter the time. 
8. Click Save Changes. 
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Configuring Tray Settings 

Use this menu to configure the paper trays for the paper size and type, set custom sizes, and turn the 
display prompts on and off. 

To configure the tray settings: 
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In CentreWare Internet Services, click Properties. 
3. To expand the menu, in the Properties pane, next to the General Setup folder, click the plus symbol 

(+). 
4. From the General Setup menu, click Tray Settings. 
5. To use the panel or print driver settings to select the Bypass Tray mode, under Tray Settings select 

Bypass Tray Mode. 
6. Under Tray Settings, next to each tray selection, select the paper size and paper type from the lists. 
7. Under Tray Settings, enter the custom paper sizes for the paper width (X) and the paper length (Y). 
8. To have the display prompt you for the paper settings each time the paper tray is loaded, next to 

the corresponding tray, select On. 
9. Under Tray Priority, select the tray priority for paper usage. 
10. Click Save Changes. 
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Configuring General Setup Using the Control 
Panel 

This section includes: 
• Getting Information About the Printer.................................................................................................................... 38 
• Using the Power On Wizard ......................................................................................................................................... 38 
 
 

Getting Information About the Printer 
1. At the printer control panel, press the Menu button. 

Note: To navigate through the menu, use the Up or Down arrow buttons. 

2. Navigate to Information Pages, then press OK. 
3. To scroll through the information pages, use the Up or Down arrows. 
4. To print a specific information page, press OK. 
 

Using the Power On Wizard 

The Power On Wizard helps to configure several preliminary settings for the printer, including the 
country, date, time, and time zone. 

For details, see the System Administrator Guide at www.xerox.com/office/WC3615docs. 
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Installing the Software 

This section includes: 
• Operating System Requirements ............................................................................................................................... 39 
• Installing the Print Drivers for a Windows Network Printer ............................................................................. 39 
• Installing the Print Drivers for a Windows USB Printer ...................................................................................... 40 
• Installing Print Drivers for Macintosh OS X Version 10.5 and Later ............................................................. 40 
• Installing Drivers and Utilities for UNIX and Linux ............................................................................................. 41 
• Other Drivers ...................................................................................................................................................................... 42 
• Installing the Printer as a Web Service on Devices ............................................................................................. 43 

Before installing driver software, verify that the printer is plugged in, turned on, connected correctly, and 
has a valid IP address. The IP address usually appears in the upper right corner of the control panel. If 
you cannot find the IP address, see Finding the IP Address of Your Printer on page 24. 

If the Software and Documentation disc is not available, download the latest drivers from 
www.xerox.com/office/3610drivers. 
 
 

Operating System Requirements 
• Windows XP SP3, Windows Vista, Windows 7, Windows 8, Windows Server 2003, Windows 

Server 2008, Windows Server 2008 R2, and Windows Server 2012. 
• Macintosh OS X version 10.5, 10.6, 10.7, and 10.8. 

UNIX and Linux: Your printer supports connection to various UNIX platforms through the network 
interface. For details, see www.xerox.com/office/3610drivers. 
 

Installing the Print Drivers for a Windows Network Printer 
1. Insert the Software and Documentation disc into the appropriate drive on your computer. 

If the installer does not start automatically, navigate to the drive, and double-click the Setup.exe 
installer file. 

2. Click Network Installation. 
3. At the bottom of the Driver Installation window, click Language. 
4. Select your language, then click OK. 
5. Click Next. 
6. To accept the agreement, click I accept the terms, then click Next. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3610&PgName=driver&Language=English�
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7. In the Discovered Printers list, select your printer, then click Next. 

Note: When installing drivers for a network printer, if you do not see your printer in the list, click the 
IP Address or DNS Name button. In the IP Address or DNS Name field, type the IP address of your 
printer, then click Search to locate your printer. If you do not know the IP address of the printer, see 
Finding the IP Address of Your Printer on page 24. 

8. To start the installation, click Next. 
9. When the installation is complete, at the Enter Printer Settings screen, select the following as 

needed: 
− Share this printer with other computers on the network 
− Set this printer as default for printing 

10. Click Next. 
11. In the Software and Documentation window, for any option you do not want to install, clear the 

check box. 
12. Click Install. 
13. At the InstallShield Wizard, click Yes to restart your computer, then click Finish. 
14. At the Product Registration screen, select your country from the list, then click Next. Complete the 

registration form, then submit it. 
 

Installing the Print Drivers for a Windows USB Printer 
1. Insert the Software and Documentation disc into the appropriate drive on your computer. 

If the installer does not start automatically, navigate to the drive, and double-click the Setup.exe 
installer file. 

2. At the bottom of the Driver Installation window, click Language. 
3. Select your language, then click OK. 
4. Select the printer model, then click Install Print and Scan Drivers. 
5. To accept the agreement, click I Agree, then click Next. 
6. At the Product Registration screen, from the list, select your country, then click Next. 
7. Complete the registration form, then click Submit. 
 

Installing Print Drivers for Macintosh OS X Version 10.5 and Later 

Install the Xerox print driver to access all features of your printer. 

To install the print driver software: 
1. Insert the Software and Documentation disc into the appropriate drive on your computer. 
2. To view the .dmg file for your printer, double-click the disc icon on your desktop. 
3. Open the .dmg file, then navigate to the appropriate installer file for your operating system. 
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4. Open the installer file. 
5. To acknowledge the warning and introductory messages, click Continue. Click Continue again. 
6. To accept the license agreement, click Continue, then click Agree. 
7. To accept the current installation location, click Install, or select another location for the installation 

files, then click Install. 
8. Enter your password, then click OK. 
9. Select your printer in the list of discovered printers, then click Continue. 
10. If your printer does not appear in the list of discovered printers: 

a. Click the Network Printer Icon. 
b. Type the IP address of your printer, then click Continue. 
c. Select your printer in the list of discovered printers, then click Continue. 

11. To accept the print queue message, click OK. 
12. To accept the installation success message, click Close. 

Note: The printer is automatically added to the printer queue in Macintosh OS X version 10.4 and 
later. 

To verify that the print driver recognizes the installed options: 
1. From the Apple menu, click System Preferences > Print and Scan. 
2. Select the printer in the list, then click Options and Supplies. 
3. Click Driver, then confirm that your printer is selected. 
4. Confirm that all of the options installed on the printer appear correct. 
5. If you change settings, click OK, close the window, then exit System Preferences. 
 

Installing Drivers and Utilities for UNIX and Linux 

Xerox® Services for UNIX Systems is a two part installation process. It requires the installation of a 
Xerox® Services for UNIX Systems code package and a printer support package. The Xerox® Services for 
UNIX Systems code package must be installed before installing the printer support package. 
 

Note: You must have root or superuser privileges to perform the UNIX print driver installation on 
your computer. 

 

1. At the printer, do the following: 
a. Verify that both the TCP/IP protocol and the proper connector are enabled. 
b. On the printer control panel, do one of the following for the IP address: 

• Allow the printer to set up a DHCP address. 
• Enter the IP address manually. 

c. Print the Configuration Report and keep it for reference. For details, see Configuration Report 
on page 23. 
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2. At your computer, do the following: 
a. Go to www.xerox.com/office/3610drivers and select your printer model. 
b. From the Operating System menu, select UNIX, then click Go. 
c. Select the Xerox® Services for UNIX Systems package for the correct operating system. This 

package is the core package and must be installed before the printer support package. 
d. To begin downloading, click the Start button. 
e. Repeat steps a and b, then click the printer package for use with the Xerox® Services for UNIX 

Systems package that you selected earlier. The second part of the driver package is ready for 
download. 

f. To begin downloading, click the Start button. 
g. In the notes below the driver package that you selected, click the link for the Installation 

Guide, then follow the installation instructions. 
 

Notes: 

• To load Linux print drivers, perform the preceding procedures but select Linux as the operating 
system. Select Xerox® Services for Linux Systems driver or the Linux CUPS Printing Package. You 
can also use the CUPS driver included in the Linux package. 

• Supported Linux drivers are available at www.xerox.com/office/3610drivers. 
• For details about UNIX and Linux drivers, see the System Administrator Guide at 

www.xerox.com/office/WC3615docs. 
 
 

Other Drivers 

The following drivers are available for download at www.xerox.com/office/3610drivers. 
• The Xerox® Global Print Driver works with any printer on your network, including those printers 

made by other manufacturers. It configures itself for your individual printer upon installation. 
• The Xerox® Mobile Express Driver works with any printer available to your computer that supports 

standard PostScript. It configures itself for the printer you select every time you print. If you travel 
frequently to the same sites, you can save your favorite printers in that location and the driver saves 
your settings. 
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Installing the Printer as a Web Service on Devices 

Web Services on Devices (WSD) allow a client to discover and access a remote device and its associated 
services across a network. WSD supports device discovery, control, and use. 

To install a WSD printer using the Add Device Wizard: 
1. At your computer, click Start, then select Devices and Printers. 
2. To launch the Add Device Wizard, click Add a Device. 
3. In the list of available devices, select the one you want to use, then click Next. 

Note: If the printer you want to use does not appear in the list, click the Cancel button. Add the 
WSD printer manually using the Add Printer Wizard. 

4. Click Close. 

To install a WSD printer using the Add Printer Wizard: 
1. At your computer, click Start, then select Devices and Printers. 
2. To launch the Add Printer Wizard, click Add a Printer. 
3. Click Add a network, wireless, or Bluetooth printer. 
4. In the list of available devices, select the one you want to use, then click Next. 
5. If the printer you want to use does not appear in the list, click The printer that I want is not listed. 
6. Select Add a printer using a TCP/IP address or hostname, then click Next. 
7. From the Device type field, select Web Services Device. 
8. Enter the printer IP address in the Hostname or IP address field, then click Next. 
9. Click Close. 
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Supported Paper 

This section includes: 
• Recommended Media .................................................................................................................................................... 46 
• Ordering Paper .................................................................................................................................................................. 46 
• General Paper Loading Guidelines ............................................................................................................................ 46 
• Paper That Can Damage Your Printer ...................................................................................................................... 47 
• Paper Storage Guidelines .............................................................................................................................................. 47 
• Supported Paper Types and Weights ....................................................................................................................... 48 
• Supported Standard Paper Sizes ................................................................................................................................ 48 
• Supported Paper Types and Weights for Automatic 2-Sided Printing ........................................................ 49 
• Supported Standard Paper Sizes for Automatic 2-Sided Printing ................................................................. 49 
• Supported Custom Paper Sizes ................................................................................................................................... 49 

Your printer is designed to use various paper and other media types. To ensure the best print quality and 
to avoid jams, follow the guidelines in this section. 

For best results, use Xerox paper and media recommended for your printer. 
 
 

Recommended Media 

A list of paper and media recommended for your printer is available at: 
• www.xerox.com/paper Recommended Media List (United States) 
• www.xerox.com/europaper Recommended Media List (Europe) 
 

Ordering Paper 

To order paper or other media, contact your local reseller or visit www.xerox.com/office/3610supplies. 
 

General Paper Loading Guidelines 
• Do not overfill the paper trays. Do not load paper above the maximum fill line in the tray. 
• Adjust the paper guides to fit the paper size. 
• Fan paper before loading it in the paper tray. 
• If excessive jams occur, use paper or other approved media from a new package. 
• Do not print on label media once a label has been removed from a sheet. 
• Use only paper envelopes. Print envelopes 1-sided only. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3610&PgName=rmlna&Language=English�
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3610&PgName=rmleu&Language=English�
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Paper That Can Damage Your Printer 

Some paper and other media types can cause poor output quality, increased paper jams, or damage 
your printer. Do not use the following: 
• Rough or porous paper 
• Inkjet paper 
• Non-laser glossy or coated paper 
• Paper that has been photocopied 
• Paper that has been folded or wrinkled 
• Paper with cutouts or perforations 
• Stapled paper 
• Envelopes with windows, metal clasps, side seams, or adhesives with release strips 
• Padded envelopes 
• Plastic media 
 

 CAUTION: The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee does not 
cover damage caused by using unsupported paper or specialty media. The Xerox Total Satisfaction 
Guarantee is available in the United States and Canada. Coverage could vary outside these areas. 
Please contact your local representative for details. 

 
 

Paper Storage Guidelines 

Storing your paper and other media properly contributes to optimum print quality. 
• Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage from 

ultraviolet and visible light. Ultraviolet light, from the sun and fluorescent bulbs, is particularly 
damaging to paper. 

• Reduce the exposure of paper to strong lights for long periods of time. 
• Maintain constant temperatures and relative humidity. 
• Avoid storing paper in attics, kitchens, garages, or basements. These spaces are more likely to collect 

moisture. 
• Store paper flat, either on pallets, cartons, shelves, or in cabinets. 
• Avoid food or drinks in the area where paper is stored or handled. 
• Do not open sealed packages of paper until you are ready to load them into the printer. Leave 

stored paper in the original packaging. The paper wrapper protects the paper from moisture loss or 
gain. 

• Some special media is packaged inside resealable plastic bags. Store the media inside the bag until 
you are ready to use it. Keep unused media in the bag and reseal it for protection. 
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Supported Paper Types and Weights 
 

Trays Paper Types Weights 

All Trays Plain 
Letterhead 
Hole Punched 
Rough Surface 
Colored 

(60–80 g/m²) 

 

Plain Thick 
Letterhead 
Hole Punched 
Colored 

(81–105 g/m²) 

Light Card (106–163 g/m²) 

Heavy Card (164–216 g/m²) 

Labels  

Bypass Tray only Envelope  
 
 

Supported Standard Paper Sizes 
 

Tray European Standard Sizes North American Standard Sizes 

All Trays A4 (210 x 297 mm, 8.3 x 11.7 in.) 
B5 (176 x 250 mm, 6.9 x 9.8 in.) 
A5 (148 x 210 mm, 5.8 x 8.3 in.) 

Legal (216 x 356 mm, 8.5 x 14 in.) 
Oficio (216 x 343 mm, 8.5 x 13.5 in.) 
Folio (216 x 330 mm, 8.5 x 13 in.) 
Letter (216 x 279 mm, 8.5 x 11 in.) 
Executive (184 x 267 mm, 7.25 x 10.5 in.) 

Bypass Tray C5 envelope (162 x 229 mm, 
6.4 x 9 in.) 
DL envelope (110 x 220 mm, 
4.33 x 8.66 in.) 

Monarch envelope (98 x 190 mm, 
3.9 x 7.5 in.) 
No. 10 envelope (241 x 105 mm, 
4.1 x 9.5 in.) 
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Supported Paper Types and Weights for Automatic 2-Sided Printing 
 

Paper Types Weights 

Plain 
Letterhead 
Hole Punched 
Colored 

(60–80 g/m²) 

 

Plain Thick 
Letterhead 
Hole Punched 
Colored 

(81–105 g/m²) 

Light Card (106–163 g/m²) 
 
 

Supported Standard Paper Sizes for Automatic 2-Sided Printing 
 

European Standard Sizes North American Standard Sizes 

A4 (210 x 297 mm, 8.3 x 11.7 in.) 
B5 (176 x 250 mm, 6.9 x 9.8 in.) 
A5 (148 x 210 mm, 5.8 x 8.3 in.) 

Legal (216 x 356 mm, 8.5 x 14 in.) 
Oficio (216 x 343 mm, 8.5 x 13.5 in.) 
Folio (216 x 330 mm, 8.5 x 13 in.) 
Letter (216 x 279 mm, 8.5 x 11 in.) 
Executive (184 x 267 mm, 7.25 x 10.5 in.) 

 
 

Supported Custom Paper Sizes 

Bypass Tray 
• Width: 76.2–215.9 mm (3–8.5 in.) 
• Length: 127–355.6 mm (5–14 in.) 

Tray 1 
• Width: 76.2–215.9 mm (3–8.5 in.) 
• Length: 127–355.6 mm (5–14 in.) 

Trays 2–4 
• Width: 139.7–215.9 mm (5.5–8.5 in.) 
• Length: 210–355.6 mm (8.3–14 in.) 
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Loading Paper 

This section includes: 
• Loading Paper in the Bypass Tray ............................................................................................................................. 50 
• Loading Small Paper Sizes in the Bypass Tray ...................................................................................................... 53 
• Configuring Trays 1–4 for the Paper Length ......................................................................................................... 56 
• Loading Paper in Trays 1–4 .......................................................................................................................................... 58 
• Configuring Tray Behavior............................................................................................................................................ 60 
 
 

Loading Paper in the Bypass Tray 
1. Open the bypass tray. If the bypass tray is loaded with paper already, remove any paper that is a 

different size or type. 

 
2. Move the width guides to the edges of the tray. 
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3. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. 
This procedure separates any sheets that are stuck together and reduces the possibility of jams. 

 
Note: To avoid jams and misfeeds, do not remove paper from its packaging until you are ready to 
use it. 

4. Load the paper in the tray. Load hole punched paper with the holes to the left. 

 
− For 1-sided printing, load letterhead or pre-printed face up with the top edge going into the 

printer. 

Note: Letterhead Duplex Mode allows 1-sided print jobs to be loaded in the same orientation as 
2-sided print jobs. For details, see Enabling Letterhead Duplex Mode on page 76. 
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− For 2-sided printing, load letterhead and pre-printed face down with the top edge facing you. 

 
Note: Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to 
jam. 

5. Adjust the width guides until they touch the edges of the paper. 

 
6. If the control panel prompts you, on the screen, verify the paper size and type. 

a. At the printer control panel, verify that the displayed paper size matches the paper in the tray. 
If correct, press OK. 

b. If the displayed paper size does not match the paper in the tray, navigate to the correct paper 
size, then press OK. 

Note: To navigate through the menu, use the Up or Down arrow buttons. 

c. Verify that the displayed paper type matches the paper in the tray. If correct, press OK. 
d. If the displayed paper type does not match the paper in the tray, navigate to the correct paper 

type, then press OK. 
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7. Verify or set the paper size and type. 
a. At the printer control panel, press the Menu button. 

Note: To navigate through the menu, use the Up or Down arrow buttons. 

b. Navigate to Tray Settings, then press OK. 
c. Navigate to the desired paper tray, then press OK. 
d. Navigate to Tray Mode, then press OK. 
e. Navigate to Panel Specified, then press OK. 
f. To return to the previous menu, press the Left arrow button. 
g. Navigate to Paper Size, then press OK. 
h. To select a setting, press the Up or Down arrow buttons, then press OK. 
i. To return to the previous menu, press the Left arrow button. 
j. Navigate to Paper Type, then press OK. 

8. To select a setting, press the Up or Down arrow buttons, then press OK. 
 

Loading Small Paper Sizes in the Bypass Tray 

To simplify loading paper in the bypass tray, remove the tray from the printer. 
1. Open the bypass tray. 

 
2. To remove the bypass tray from the printer, pull the tray straight out of the printer. 
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3. If the bypass tray is loaded with paper already, remove any paper that is a different size or type. 
Then, raise the paper stop. 

 
4. Move the width guides to the edges of the tray. 

 
5. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. 

This procedure separates any sheets that are stuck together and reduces the possibility of jams. 

 
Note: To avoid jams and misfeeds, do not remove paper from its packaging until you are ready to 
use it. 

6. Load the paper in the tray. 

 
Note: Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to 
jam. 
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7. Adjust the width guides until they touch the edges of the paper. 

 
8. Adjust the paper stop until it touches the edges of the paper. 

 
9. Slide the tray back into the printer. 

 
10. If the control panel prompts you, on the screen, verify the paper size and type. 

a. At the printer control panel, verify that the displayed paper size matches the paper in the tray. 
If correct, press OK. 

b. If the displayed paper size does not match the paper in the tray, navigate to the correct paper 
size, then press OK. 

Note: To navigate through the menu, use the Up or Down arrow buttons. 

c. Verify that the displayed paper type matches the paper in the tray. If correct, press OK. 
d. If the displayed paper type does not match the paper in the tray, navigate to the correct paper 

type, then press OK. 
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11. Verify or set the paper size and type. 
a. At the printer control panel, press the Menu button. 

Note: To navigate through the menu, use the Up or Down arrow buttons. 

b. Navigate to Tray Settings, then press OK. 
c. Navigate to the desired paper tray, then press OK. 
d. Navigate to Tray Mode, then press OK. 
e. Navigate to Panel Specified, then press OK. 
f. To return to the previous menu, press the Left arrow button. 
g. Navigate to Paper Size, then press OK. 
h. To select a setting, press the Up or Down arrow buttons, then press OK. 
i. To return to the previous menu, press the Left arrow button. 
j. Navigate to Paper Type, then press OK. 
k. To select a setting, press the Up or Down arrow buttons, then press OK. 

For instructions on setting tray prompts, see Configuring Tray Behavior on page 60. 
 

Configuring Trays 1–4 for the Paper Length 

You can adjust the lengths of trays 1–4 to accommodate A4/Letter and Legal paper sizes. In the Legal 
length settings, the trays protrude from the front of the printer. 

To change the 550-Sheet Feeders in trays 1–4 to match the paper length: 
1. Remove all paper from the tray. 
2. To remove the tray from the printer, pull out the tray until it stops, lift the front of the tray slightly, 

then pull it out. 
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3. To extend the tray, with one hand, hold the back of the tray. With the other hand, at the front of 
the tray, press the release latch and pull the ends outward until they latch. 

 
4. To protect the paper, place the paper cover over the extended section of the paper tray. 

 
5. To compress the tray for shorter paper, with one hand, hold the back of the tray. With the other 

hand, at the front of the tray, press the release latch, then push the ends inward until they latch. 
6. Load paper into the tray, then insert it back into the printer. For details, see Loading Paper in Trays 

1-4 on page 66. 
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Loading Paper in Trays 1–4 
1. Pull out the tray until it stops. 
2. To remove the tray from the printer, pull out the tray until it stops, lift the front of the tray slightly, 

then pull it out. 

 
3. At the back of the paper tray, press the paper lift tray down until it locks. 
4. Adjust the paper length and width guides as illustrated. 

 
5. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. 

This procedure separates any sheets that are stuck together and reduces the possibility of jams. 

 
6. Load paper into the tray with the print side face up. 

− Load hole punched paper with the holes to the left. 
− For 1-sided printing, load letterhead face up with the top of the paper toward the back of the 

tray. 

Note: Letterhead Duplex Mode allows 1-sided print jobs to be loaded in the same orientation as 
2-sided print jobs. For details, see Enabling Letterhead Duplex Mode on page 76. 

− For 2-sided printing, load letterhead and pre-printed face down with the top edge facing you. 
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Note: Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to 
jam. 

 
7. Adjust the length and width guides to fit the paper. 

 
8. Slide the tray back into the printer. 

 
9. Push the tray in all the way.  

Notes: 

• If the tray does not go in all the way, ensure that the paper lift plate at the back of the tray is 
locked down. 

• If the tray is extended for legal size paper, the tray protrudes when it is inserted into the 
printer. 



Paper and Media 

 

60 Xerox® Phaser® 3610 Black and White Printer 
 User Guide 
 

10. If the control panel prompts you, on the screen, verify the paper size and type. 
a. At the printer control panel, verify that the displayed paper size matches the paper in the tray. 

If correct, press OK. 
b. If the displayed paper size does not match the paper in the tray, navigate to the correct paper 

size, then press OK. 

Note: To navigate through the menu, use the Up or Down arrow buttons. 

c. Verify that the displayed paper type matches the paper in the tray. If correct, press OK. 
d. If the displayed paper type does not match the paper in the tray, navigate to the correct paper 

type, then press OK. 
11. Verify or set the paper size and type. 

a. At the printer control panel, press the Menu button. 

Note: To navigate through the menu, use the Up or Down arrow buttons. 

b. Navigate to Tray Settings, then press OK. 
c. Navigate to the desired paper tray, then press OK. 
d. Navigate to Tray Mode, then press OK. 
e. Navigate to Panel Specified, then press OK. 
f. To return to the previous menu, press the Left arrow button. 
g. Navigate to Paper Size, then press OK. 
h. To select a setting, press the Up or Down arrow buttons, then press OK. 
i. To return to the previous menu, press the Left arrow button. 
j. Navigate to Paper Type, then press OK. 

12. To select a setting, press the Up or Down arrow buttons, then press OK. 
 

Configuring Tray Behavior 

When an individual tray is set to Display Popup mode, the control panel prompts you to verify or set the 
paper size and type. 

The Tray Priority feature determines the order in which the printer selects the tray for a print job when 
you have not specified one. Tray Priority also determines how the printer selects another tray when a 
paper tray runs out in the middle of a job. Priority 1 indicates that the tray is set to the highest priority. 

Tray Mode allows you to have the bypass tray mode determined at the control panel or the print driver. 

To set the Display Popup mode: 
1. At the printer control panel, press the Menu button. 

Note: To navigate through the menu, use the Up or Down arrow buttons. 

2. Navigate to Tray Settings, then press OK. 
3. Navigate to the desired paper tray, then press OK. 
4. Navigate to Display Popup, then press OK. 
5. Navigate to On, then press OK. 
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To set the priority for a tray: 
1. At the printer control panel, press the Menu button. 

Note: To navigate through the menu, use the Up or Down arrow buttons. 

2. Navigate to Tray Settings, then press OK. 
3. To determine the order in which the printer selects the tray for a print job, navigate to Tray Priority, 

then press OK. 
4. To specify the first priority, use the Up or Down arrow buttons, then press OK. The second priority 

setting appears. 
5. Navigate to the desired paper tray for the second priority, then press OK. 
6. To establish the priority for any remaining trays, repeat steps 4 and 5. 

Note: As each priority is assigned to a tray, the menu automatically advances to the next priority. 
When there are no trays left to prioritize, the menu returns to Tray Priority. 

To set the Tray Mode: 
1. At the printer control panel, press the Menu button. 

Note: To navigate through the menu, use the Up or Down arrow buttons. 

2. Navigate to Tray Settings, then press OK. 
3. Navigate to Bypass Tray, then press OK. 
4. Navigate to Tray Mode, then press OK. 
5. Navigate to Panel Specified or Driver Specified, then press OK. 
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Printing on Special Paper 

This section includes: 
• Envelopes ............................................................................................................................................................................ 62 
• Labels .................................................................................................................................................................................... 65 

To order paper or other media, contact your local reseller or visit www.xerox.com/office/3610supplies. 
 

See also:  
www.xerox.com/paper Recommended Media List (United States) 
www.xerox.com/europaper Recommended Media List (Europe) 
 

 
 

Envelopes 

You can print envelopes from the bypass tray only. 
 

Guidelines for Printing Envelopes 
• Print quality depends on the quality and construction of the envelopes. Try another envelope brand 

if you do not get desired results. 
• Maintain constant temperatures and relative humidity. 
• Store unused envelopes in their packaging to avoid excess moisture and dryness which can affect 

print quality and cause wrinkling. Excessive moisture can cause the envelopes to seal before or 
during printing. 

• Remove air bubbles from the envelopes before loading them into the tray by setting a heavy book 
on top of them. 

• In the print driver software, select Envelope as the paper type. 
• Do not use padded envelopes. Use envelopes that lie flat on a surface. 
• Do not use envelopes with heat activated glue. 
• Do not use envelopes with press and seal flaps. 
• Use only paper envelopes. 
• Do not use envelopes with windows or metal clasps. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3610&PgName=order&Language=English�
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Loading Envelopes in the Bypass Tray 
1. Open the bypass tray. 

 
2. Move the width guides to the edges of the tray. 

 
Note: If you do not load envelopes in the bypass tray right after they have been removed from the 
packaging, they can bulge. Flatten them to avoid jams. 
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3. To load envelopes, select an option: 
− For Number 10 envelopes, load the envelopes with the short edge going into the printer, flaps 

down, and flaps to the right. 

 
− For C5 envelopes, do one of the following. If the envelopes wrinkle, try another option. 

• Insert envelopes with the print side up, flaps closed and down, and flaps going into the 
printer. 

 



Paper and Media 

 

 Xerox® Phaser® 3610 Black and White Printer 65 
 User Guide 
 

• Insert envelopes with the print side up, flaps closed and down, and flaps going into the 
printer. 

 

Note: When loading Monarch or DL envelopes, remove the Multipurpose Tray. For details, see 
Loading Small Paper Sizes in the Bypass Tray on page 53. 

 
4. At the printer control panel, press the Menu button. 

Note: To navigate through the menu, use the Up or Down arrow buttons. 

5. Navigate to Tray Settings, then press OK. 
6. Navigate to Bypass Tray, then press OK. 
7. Navigate to Tray Mode, then press OK. 
8. Navigate to Panel Specified, then press OK. 
9. To return to the previous menu, press the Left arrow button. 
10. Navigate to Paper Type, then press OK. 
11. Navigate to Envelope, then press OK. 
12. To return to the previous menu, press the Left arrow button. 
13. Navigate to Paper Size, then press OK. 
14. Navigate to the desired envelope size, then press OK. 
 

Labels 

You can print labels from any tray. 
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Loading Labels in the Bypass Tray 
1. Remove all paper from the tray. 
2. Load labels in the bypass tray, face up, with the top edge of the page feeding into the printer only. 
3. Adjust the width guides until they touch the edges of the paper. 
4. At the printer control panel, press the Menu button. 

Note: To navigate through the menu, use the Up or Down arrow buttons. 

5. Navigate to Tray Settings, then press OK. 
6. Navigate to Bypass Tray, then press OK. 
7. Navigate to Tray Mode, then press OK. 
8. Navigate to Panel Specified, then press OK. 
9. To return to the previous menu, press the Left arrow button. 
10. Navigate to Paper Type, then press OK. 
11. Navigate to Labels, then press OK. 
 

Loading Labels in Trays 1-4 
1. Remove all paper from the tray. 
2. Load labels face up with the top edge of the page toward the rear of the tray. 
3. Adjust the width guides until they touch the edges of the paper. 
4. At the printer control panel, press the Menu button. 

Note: To navigate through the menu, use the Up or Down arrow buttons. 

5. Navigate to Tray Settings, then press OK. 
6. Navigate to the desired paper tray, then press OK. 
7. Navigate to Paper Size, then press OK. 
8. To select a setting, press the Up or Down arrow buttons, then press OK. 
9. To return to the previous menu, press the Left arrow button. 
10. Navigate to Paper Type, then press OK. 
11. Navigate to Labels, then press OK. 
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Guidelines for Printing Labels 
• Use labels designed for laser printing. 
• Do not use vinyl labels. 
• Do not feed a sheet of labels through the printer more than once. 
• Do not use dry gum labels. 
• Print only on one side of the sheet of labels. Use full sheet labels only. 
• Store unused labels flat in their original packaging. Leave the sheets of labels inside the original 

packaging until ready to use. Return any unused sheets of labels to the original packaging and 
reseal it. 

• Do not store labels in extremely dry or humid conditions or extremely hot or cold conditions. Storing 
them in extreme conditions can cause print-quality problems or cause them to jam in the printer. 

• Rotate stock frequently. Long periods of storage in extreme conditions can cause labels to curl and 
jam in the printer. 

• In the print driver software, select Label as the paper type. 
• Remove all other paper from the tray before loading labels. 
 

 CAUTION: Do not use any sheet where labels are missing, curled, or pulled away from the backing 
sheet. It could damage the printer. 
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This chapter includes: 
• Printing Overview ............................................................................................................................................................. 70 
• Selecting Printing Options ............................................................................................................................................ 71 
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Printing Overview 

Before printing, your computer and the printer must be plugged in, turned on, and connected. Ensure 
that you have the correct print driver software installed on your computer. For details, see Installing the 
Software on page 39. 
1. Select the appropriate paper. 
2. Load paper in the appropriate tray. 
3. At the printer control panel, specify the size and type. 
4. In your software application, access the print settings. For most software applications, press CTRL+P 

for Windows or CMD+P for Macintosh. 
5. Select your printer from the list. 
6. To access the print driver settings for Windows, select Properties or Preferences. For Macintosh 

select Xerox® Features. 

Note: The title of the button varies depending on your application. 

7. Modify the print driver settings as needed, then click OK. 
8. Click Print to send the job to the printer. 
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Selecting Printing Options 

This section includes: 
• Print Driver Help................................................................................................................................................................ 71 
• Windows Printing Options ............................................................................................................................................ 72 
• Macintosh Printing Options ......................................................................................................................................... 73 

Printing options, also called print driver software options, are specified as Printing Preferences in 
Windows, and Xerox® Features in Macintosh. Printing options include settings for 2-sided printing, page 
layout, and print quality. Printing options that are set from Printing Preferences become the default 
setting. Printing options that are set from within the software application are temporary. The application 
and the computer do not save the settings after the application is closed. 
 
 

Print Driver Help 

Xerox® print driver software Help information is available from the Printing Preferences window. Click the 
Help (?) button in the bottom left corner of the Printing Preferences window to see the Help. 

 

Information about Printing Preferences appears in the Help window. From there, you can select by topic 
or use the search field to enter the topic or function for which you need information. 
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Windows Printing Options 

Setting Default Printing Options for Windows 

When you print from any software application, the printer uses the print job settings specified in the 
Printing Preferences window. You can specify your most common printing options and save them so that 
you do not have to change them every time you print. 

For example, if you want to print on both sides of the paper for most jobs, specify 2-sided printing in 
Printing Preferences. 

To select default printing options: 
1. Navigate to the list of printers on your computer: 

− For Windows XP SP2 and later, click Start > Settings > Printers and Faxes. 
− For Windows Vista, click Start > Control Panel > Hardware and Sound > Printers. 
− For Windows Server 2003 and later, click Start > Settings > Printers. 
− For Windows 7, click Start > Devices and Printers. 
− For Windows 8, click Control Panel > Devices and Printers. 

Note: If the Control Panel icon does not display on the desktop, right-click on the desktop, then, 
select Personalize > Control Panel Home > Devices and Printers. 

2. In the list, right-click the icon for your printer and click Printing Preferences. 
3. In the Printing Preferences window, click a tab, select the options, then click OK to save. 

Note: For more information about Windows print driver options, click the Help button (?) in the 
Printing Preferences window. 

 

Selecting Printing Options for an Individual Job for Windows 

To use special printing options for a particular job, change the Printing Preferences from the application 
before sending the job to the printer. For example, if you want to use the Enhanced print-quality mode 
when printing a particular document, select Enhanced in Printing Preferences before printing the job. 
1. With the document open in your software application, access the print settings. For most software 

applications, click File > Print or press CTRL+P for Windows. 
2. Select your printer and click the Properties or Preferences button to open the Printing Preferences 

window. The title of the button can vary depending on your application. 
3. Click a tab in the Printing Preferences window, then make selections. 
4. Click OK to save and close the Printing Preferences window. 
5. Click Print to send the job to the printer. 
 
 

Saving a Set of Commonly Used Printing Options for Windows 

You can define and save a set of options, so that you can apply them to future print jobs. 

To save a set of printing options: 
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1. With the document open in your application, click File > Print. 
2. To open the Printing Preferences window, select your printer, then click Properties or Preferences. 
3. In the Printing Properties window, click the tabs, then select the desired settings 
4. At the bottom of the Printing Properties window, click Saved Settings, then click Save As. 
5. To save the set of options in the Saved Settings list, type a name for the set of printing options, then 

click OK. 
6. To print using these options, select the name from the list. 
 

Macintosh Printing Options 

Selecting Printing Options for Macintosh 

To use specific printing options, change the settings before sending the job to the printer. 
1. With the document open in your application, click File > Print. 
2. Select your printer from the list. 
3. Select Xerox® Features from the Copies & Pages menu. 
4. Select the desired printing options from the drop-down lists. 
5. Click Print to send the job to the printer. 
 
 

Saving a Set of Commonly Used Printing Options for Macintosh 

You can define and save a set of options, so that you can apply them to future print jobs. 

To save a set of printing options: 
1. With the document open in your application, click File > Print. 
2. Select your printer from the Printers list. 
3. Select the desired printing options from the drop-down lists in the Print dialog box. 
4. Click Presets > Save As. 
5. Type a name for the printing options, then click OK to save the set of options in the Presets list. 
6. To print using these options, select the name from the Presets list. 
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Printing Features 

This section includes: 
• Printing on Both Sides of the Paper .......................................................................................................................... 74 
• Orientation ......................................................................................................................................................................... 76 
• Selecting Paper Options for Printing ......................................................................................................................... 76 
• Enabling Letterhead 2-Sided Mode .......................................................................................................................... 76 
• Printing Multiple Pages to a Single Sheet ............................................................................................................... 77 
• Printing Booklets .............................................................................................................................................................. 77 
• Print Quality ....................................................................................................................................................................... 78 
• Lightness ............................................................................................................................................................................. 78 
• Printing Watermarks ....................................................................................................................................................... 78 
• Scaling .................................................................................................................................................................................. 79 
• Printing Mirror Images ................................................................................................................................................... 79 
• Printing Special Job Types ............................................................................................................................................ 79 
 
 

Printing on Both Sides of the Paper 

Printing a 2-Sided Document 

If your printer supports Automatic 2-Sided Printing, the options are specified in the print driver. The print 
driver uses the settings for portrait or landscape orientation from the application for printing the 
document. 

Note: Ensure that the paper size and weight are supported. For details, see Supported Paper Sizes and 
Weights for Automatic 2-Sided Printing on page 49. 
 

Setting Up 1-Sided Printing 

To set 1-sided printing as the default setting: 
1. Navigate to the list of printers on your computer. 
2. From the Printers and Faxes window, select a printer, right-click the printer, then select Printing 

preferences. 
3. On the Printing Options tab, click the arrow to the right of the 2-Sided Printing, then select 1-Sided 

Print. 
4. To close the Printing Preferences dialog box, click OK. 
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2-Sided Page Layout Options 

You can specify the page layout for 2-sided printing, which determines how the printed pages turn. 
These settings override the application page orientation settings. 

To make a 2-sided printing selection, on the Page Layout tab, use the arrow button in the bottom left 
corner of the preview pane. Page Layout is on the Document Options tab. 

 
• 1-Sided Print prints on one side of the media. Use this option when printing on envelopes, labels, or 

other media that cannot be printed on both sides. 
• 2-Sided Print prints the job on both sides of the paper to allow binding on the long edge of the 

paper. The following illustrations show the result for documents with portrait and landscape 
orientations, respectively: 

   
 

• 2-Sided Print, Flip on Short Edge prints on both sides of the paper. The images print to allow 
binding on the short edge of the paper. The following illustrations show the result for documents 
with portrait and landscape orientations, respectively: 

   
 

Note: 2-Sided Printing is part of the Earth Smart settings. 

To change your default print driver settings, see Setting Default Printing Options for Windows. 
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Orientation 

To select the default orientation: 
1. In the print driver, on the Document Options tab, click the Orientation tab. 
2. Select an option: 

− Portrait orients the paper so that the text and images print across the short dimension of the 
paper. 

 
− Landscape orients the paper so that the text and images print across the long dimension of 

the paper. 

 
− Rotated Landscape orients the paper so that the content is rotated 180 degrees and with the 

long bottom side up. 

 
3. Click OK. 
 

Selecting Paper Options for Printing 

There are two ways to select the paper for your print job. You can let the printer select which paper to 
use based on the document size and paper type that you specify. You can also select a specific tray 
loaded with the desired paper. 
 

Enabling Letterhead 2-Sided Mode 

Letterhead Duplex Mode allows you to load 1-sided print jobs in the same orientation as 2-sided print 
jobs. Enabling this feature allows you to print 1-sided or 2-sided print jobs from the same tray without 
switching paper orientation. 

To enable Letterhead Duplex Mode: 
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In CentreWare Internet Services, click Properties. 
3. To expand the menu, in the Properties pane, next to the General Setup folder, click the plus symbol 

(+). 
4. From the General Setup menu, click System Settings. 
5. Under Output Settings, next to Letterhead Duplex Mode, click Enable. 
6. Click Save Changes. 
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Printing Multiple Pages to a Single Sheet 

When printing a multiple-page document, you can print more than one page on a single sheet of paper. 
Print 1, 2, 4, 6, 9, or 16 pages per side by selecting Pages Per Sheet on the Page Layout tab. Page Layout 
is on the Document Options tab. 

 
 

Printing Booklets 

With 2-sided printing, you can print a document in the form of a small booklet. Create booklets from any 
paper size that is supported for 2-sided printing. The driver automatically reduces each page image and 
prints four page images per sheet of paper, two page images on each side. The pages are printed in the 
correct order so that you can fold and staple the pages to create the booklet. 

When you print booklets using the Windows PostScript or Macintosh driver, you can specify the gutter 
and creep. 
• Gutter specifies the horizontal distance in points between the page images. A point is 0.35 mm 

(1/72 in.). 
• Creep specifies how much the page images are shifted outward, in tenths of a point. Shifting 

compensates for the thickness of the folded paper, which would cause the page images to shift 
slightly outward when folded. You can select a value from zero to 1 point. 

 

Gutter Creep 

 
 Error!Error! 
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Print Quality 

Print quality modes: 
• Standard print-quality mode: 600 x 600 dpi 
• Enhanced print-quality mode: 1200 x 1200 dpi 
 

Lightness 

Lightness allows you to adjust the overall lightness or darkness of the text and images in your printed 
job. 
1. To adjust the lightness, on the Image Options tab, move the slider to the right to lighten or to the 

left to darken your print job. 
2. Click OK or Apply. 
 

Printing Watermarks 

A watermark is special purpose text that can be printed across one or more pages. For example, you can 
add a word like Copy, Draft, or Confidential as a watermark instead of stamping it on a document before 
distribution. 

To print a watermark: 
1. In the print driver, click the Document Options tab. 
2. Click the Watermarks tab. 
3. From the Watermark menu, select the watermark. You can choose from preset watermarks, or 

create a customized watermark. You can also manage watermarks from this menu. 
4. Under Text, select an option: 

− Text: Enter the text in the field, then specify the font. 
− Time Stamp: Specify the date and time options, then specify the font. 
− Picture: To locate the picture, click the Browse icon. 

5. Specify the scaling angle and position of the watermark. 
• Select the scaling option that specifies the size of the picture in relation to the original 

image.. Use the arrows to scale the image in increments of 1%. 
• To define the angle of the image on the page, specify the position option or to rotate the 

image left or right by increments of 1, use the arrows. 
• To define the location of the image on the page, specify the position option, or to move 

the image in each direction in increments of 1, use the arrows. 
6. Under Layering, select how to print the watermark. 

− Print in Background prints the watermark behind the text and graphics in the document. 
− Blend combines the watermark with the text and graphics in the document. A blended 

watermark is translucent, so you can see both the watermark and the document content. 
− Print in Foreground prints the watermark over the text and graphics in the document. 



Printing 

 

 Xerox® Phaser® 3610 Black and White Printer 79 
 User Guide 
 

7. Click Pages, then select the pages to print the watermark: 
− Print on All Pages prints the watermark on all pages of your document. 
− Print on Page 1 Only prints the watermark only on the first page of the document. 

8. If you select a picture as a watermark, specify the lightness settings for the image. 
9. Click OK. 
 

Scaling 

Scaling reduces or enlarges the original document to match the selected output paper size. In Windows, 
the Scale Options are located in the print driver on the Printing Options tab in the Paper field. 

To access Scaling Options, to the right of the Paper field, click the arrow, then select Other Size > 
Advanced Paper Size. 
• Automatically Scale scales the document to fit the selected Output Paper Size. The scaling amount 

appears in the percentage box below the sample image. 
• No Scaling does not change the size of the page image printed on the output paper, and 100% 

appears in the percentage box. If the original size is larger than the output size, the page image is 
cropped. If the original size is smaller than the output size, extra space appears around the page 
image. 

• Manually Scale scales the document by the amount entered in the percentage box below the 
preview image. 

 

Printing Mirror Images 

If the PostScript driver is installed, you can print pages as a mirror image. Images mirror left to right 
when printed. 
 

Printing Special Job Types 

Special job types allow you to send a print job from your computer, then print it from the printer control 
panel. Select special job types in the print driver, Printing Options tab, under Job Type. 

Note: Special job types stored on the RAM disk on the printer are removed when the printer powers 
off. To store the special job types permanently, install the Device Memory option on the printer. 

 



Printing 

 

80 Xerox® Phaser® 3610 Black and White Printer 
 User Guide 
 

Saved Job 

Saved jobs are documents sent to the printer and stored there for future use. 

Note: This function is available only if RAM Disk is enabled or the Device Memory option is installed. 

To release a saved job: 
1. To access the Walk-Up Features menu, click the Left arrow button. 
2. Navigate to Saved Jobs, then press OK. 
3. Navigate to your username, then press OK. 
4. Navigate to the desired job, then press OK. 
5. Select an option. 
6. Press OK. 
 

Secure Print 

Secure Print allows you to associate a 1–12 digit passcode number with a print job when sending it to 
the printer. The job is held at the printer until the same passcode is entered at the control panel. 

Notes: 

• This function is available only if RAM Disk is enabled or the Device Memory option is installed. 
• If the control panel is dark, press the Power Saver button. 
• To navigate through the menu, use the Up or Down arrow buttons. 

To release a Secure Print job for printing: 
1. To access the Walk-Up Features menu, click the Left arrow button. 
2. Navigate to Secure Print, then press OK. 
3. Navigate to your username, then press OK. 
4. To enter your passcode, use the arrow buttons, then press OK. 
5. Navigate to the desired job, then press OK. 
6. Select an option. If you selected Delete after Print, to specify the number of print jobs, use the 

arrow buttons. 
7. Press OK. 
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Using Custom Paper Sizes 

This section includes: 
• Defining Custom Paper Sizes ....................................................................................................................................... 81 
• Creating and Saving Custom Paper Sizes ............................................................................................................... 81 
• Printing on Custom Paper Sizes .................................................................................................................................. 82 

The Xerox® Phaser® 3610 Black and White Printer prints on custom paper sizes that are within the 
minimum and maximum size range supported by the printer. For details, see Supported Standard 
Paper Sizes on page 48 and Supported Custom Paper Sizes on page 49. 

 
 

Defining Custom Paper Sizes 

To print custom paper sizes, define the custom width and length of the paper in the print driver software 
and on the printer control panel. When setting the paper size, ensure that you specify the same size as 
the paper in the tray. Setting the wrong size can cause a printer error. Print driver settings override 
control panel settings when you print using the print driver software on your computer. 
 

Creating and Saving Custom Paper Sizes 

You can print custom-size paper from any paper tray. Custom-size paper settings are saved in the print 
driver and are available for you to select in all your applications. 

For detail on supported paper sizes for each tray, see Supported Custom Paper Sizes on page 49. 

To create and save custom sizes for Windows: 
1. Click the Printing Options tab of the print driver. 
2. Click the arrow next to the Paper field, then select Other Size > Output Paper Size > New. 
3. In the New Custom Paper Size window, enter the height and width of the new size. 
4. At the bottom of the New Custom Paper Size window, click Units . 
5. Click Inches or Millimeters. 
6. To save, in the Name field, type a title for the new size, then click OK. 
7. Click OK. 
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To create and save custom sizes for Macintosh: 
1. In the application, click File > Page Setup. 
2. Click Paper Sizes, then select Manage Paper Sizes. 
3. To add a new size, in the Manage Paper Sizes window, click the plus sign (+). 
4. Double-click Untitled at the top of the window and type a name for the new custom size. 
5. Enter the height and width of the new custom size. 
6. Click the arrow to the right of the Non-Printable Area field and select the printer from the list. Or set 

the top, bottom, right, and left margins for User Defined margins. 
7. To save the settings, click OK. 
 

Printing on Custom Paper Sizes 
 

Note: Before printing on a custom paper size, use the Custom Paper Sizes feature in printer 
properties to define the custom size. For details, see Defining Custom Paper Sizes on page 81. 

 
 

Printing on Custom Paper Size Using Windows 
1. Load the custom-size paper in the tray. For details, see Loading Paper on page 50. 
2. In the application, click File > Print and select your printer. 
3. In the Print dialog box, click Properties. 
4. On the Printing Options tab, to select the desired custom size, use the Paper drop-down list. 

Note: If you are printing on custom size paper, define the custom size in the printer properties 
before printing. 

5. From the Other Type drop-down list, select the paper type. 
6. Select any other desired options, then click OK. 
7. In the Print dialog box, click OK to start printing. 
 

Printing on Custom Paper Size Using Macintosh 
1. Load the custom-size paper. For details, see Loading Paper on page 50. 
2. In the application, click Page Setup. 
3. From the Paper Size drop-down list, select the custom paper size. 
4. Click OK. 
5. In the application, click Print. 
6. Click OK. 
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This chapter includes: 
• Cleaning the Printer ........................................................................................................................................................ 84 
• Ordering Supplies ............................................................................................................................................................. 86 
• Managing the Printer ..................................................................................................................................................... 90 
• Moving the Printer ........................................................................................................................................................... 99 
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Cleaning the Printer 

This section includes: 
• General Precautions ........................................................................................................................................................ 84 
• Cleaning the Exterior ...................................................................................................................................................... 85 
• Cleaning the Interior ...................................................................................................................................................... 85 
 
 

General Precautions 
 

 CAUTION: Do not expose the drum cartridge to direct sunlight or strong indoor fluorescent lighting. 
Do not touch or scratch the surface of the drum. 

  

 CAUTION: When cleaning your printer do not use organic or strong chemical solvents or aerosol 
cleaners. Do not pour fluids directly into any area. Use supplies and cleaning materials only as 
directed in this documentation. 

  

 WARNING: Keep all cleaning materials out of the reach of children. 
  

 WARNING: Do not use pressurized spray cleaning aids on or in the printer. Some pressurized sprays 
contain explosive mixtures and are not suitable for use in electrical applications. Use of such cleaners 
increase the risk of fire and explosion. 

  

 WARNING: Do not remove the covers or guards that are fastened with screws. You cannot maintain 
or service any parts that are behind these covers and guards. Do not attempt any maintenance 
procedure that is not described in the documentation supplied with your printer. 

  

 WARNING: Internal parts of the printer can be hot. Use caution when doors and covers are open. 
 

• Do not place anything on top of the printer. 
• Do not leave the covers and doors open for any length of time, especially in well-lit places. Light 

exposure can damage the drum cartridge. 
• Do not open covers and doors during printing. 
• Do not tilt the printer while it is in use. 
• Do not touch the electrical contacts or gears. Doing so could damage the printer and cause the print 

quality to deteriorate. 
• Ensure any parts removed during cleaning are replaced before you plug in the printer. 
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Cleaning the Exterior 

Clean the exterior of the printer once a month. 
• Wipe the paper tray, output tray, control panel, and other parts with a damp, soft cloth. 
• After cleaning, wipe with a dry, soft cloth. 
• For stubborn stains, apply a small amount of mild detergent to the cloth and gently wipe the stain 

off. 
 

 CAUTION: Do not spray detergent directly on the printer. Liquid detergent could enter the printer 
through a gap and cause problems. Never use cleaning agents other than water or mild detergent. 

 
 

Cleaning the Interior 

To prevent stains inside the printer that can deteriorate print quality, clean the interior of the printer 
regularly. Clean the printer interior whenever you replace the drum cartridge. 

After clearing paper jams or replacing a toner cartridge, inspect the inside of the printer before closing 
the printer covers and doors. 
• Remove any remaining pieces of paper or debris. For details, see Clearing Paper Jams on page 107. 
• Remove any dust or stains with a dry, clean cloth. 
  

 WARNING: Never touch a labeled area on or near the heat roller in the fuser. You can get burned. If 
a sheet of paper is wrapped around the heat roller, do not try to remove it immediately. Switch off 
the printer immediately and wait 40 minutes for the fuser to cool. Try to remove the jam after the 
printer has cooled. 
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Ordering Supplies 

This section includes: 
• Consumables ..................................................................................................................................................................... 86 
• Routine Maintenance Items ........................................................................................................................................ 86 
• When to Order Supplies ................................................................................................................................................. 87 
• Viewing Printer Supply Status ..................................................................................................................................... 87 
• Toner Cartridges ............................................................................................................................................................... 88 
• Recycling Supplies ............................................................................................................................................................ 89 
 
 

Consumables 

Consumables are printer supplies that get depleted during the operation of the printer. The consumable 
supply for this printer is the genuine Xerox® Black Toner Cartridge. 
 

Notes: 

• Each consumable includes installation instructions. 
• Install only new cartridges in your printer. If a used toner cartridge is installed, then the toner 

remaining amount displayed could be inaccurate. 
• To ensure print quality, the toner cartridge has been designed to cease functioning at a 

predetermined point. 
 

 CAUTION: Use of toner other than genuine Xerox® Toner can affect print quality and printer 
reliability. Xerox® Toner is the only toner designed and manufactured under strict quality controls by 
Xerox for specific use with this printer. 

 
 

Routine Maintenance Items 

Routine maintenance items are printer parts that have a limited life and require periodic replacement. 
Replacements can be parts or kits. Routine maintenance items are typically customer replaceable. 
 

Note: Each routine maintenance item includes installation instructions. 
 

Routine maintenance items for this printer include the following: 

• Smart Kit Drum Cartridge 
• Maintenance Kit, which includes a Fuser, Transfer Unit, and Feed Rollers 
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When to Order Supplies 

A warning appears on the control panel when the Toner Cartridge or the Smart Kit Drum Cartridge are 
near their replacement time. Verify that you have replacements on hand. It is important to order these 
items when the messages first appear to avoid interruptions to your printing. An error message appears 
on the control panel when the Toner Cartridge or the Smart Kit Drum Cartridge must be replaced. 

Order supplies from your local reseller or go to www.xerox.com/office/3610supplies. 
 

 CAUTION: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service Agreement, 
and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of performance 
caused by use of non-Xerox supplies, or the use of Xerox supplies not specified for this printer. The 
Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary 
outside these areas. Please contact your Xerox representative for details. 

 
 

Viewing Printer Supply Status 

You can check the status and percentage of life remaining for your printer supplies at any time using 
CentreWare Internet Services. 
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: For details, see the System Administrator Guide at www.xerox.com/office/WC3615docs. 

2. Select the Status tab. 
3. Under Status, click Supplies. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3610&PgName=order&Language=English�
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC3615&PgName=Man&Language=English�
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Toner Cartridges 

This section includes: 
• General Precautions ........................................................................................................................................................ 88 
• Replacing a Toner Cartridge ........................................................................................................................................ 88 
 
 

General Precautions 
 

 WARNINGS:  

• When replacing a toner cartridge, be careful not to spill the toner. If any toner spills, avoid 
contact with clothes, skin, eyes, and mouth. Do not inhale the toner dust. 

• Keep toner cartridges out of the reach of children. If a child accidentally swallows toner, have the 
child spit out the toner, and rinse out their mouth with water. Consult a physician immediately. 

• Use a damp cloth to wipe off spilled toner. Never use a vacuum cleaner to remove spills. Electric 
sparks inside the vacuum cleaner can cause a fire or explosion. If you spill a large volume of 
toner, contact your local Xerox representative. 

• Never throw a toner cartridge into an open flame. Remaining toner in the cartridge can catch 
fire and cause burn injuries or an explosion. 

 

 WARNING: Do not remove the covers or guards that are fastened with screws. You cannot maintain 
or service any parts that are behind these covers and guards. Do not attempt any maintenance 
procedure that is not described in the documentation supplied with your printer. 

 

• Do not open covers and doors during printing. 
• Do not leave the covers and doors open for any length of time, especially in well-lit places. Light 

exposure can damage the drum cartridge. 
• Do not place anything on top of the printer. 
• Do not tilt the printer while it is in use. 
• Do not touch the electrical contacts or gears. Doing so could damage the printer and cause the print 

quality to deteriorate. 
• Ensure any parts removed during cleaning are replaced before you plug in the printer. 
 

Replacing a Toner Cartridge 

When a toner cartridge approaches the end of its usable life span, the control panel displays a toner low 
message. When a toner cartridge is empty, the printer stops and displays a message on the control 
panel. 

Install only new cartridges in your printer. If a used toner cartridge is installed, then the toner remaining 
amount displayed could be inaccurate. 

Note: Each toner cartridge includes installation instructions. 
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Printer Status Message Cause and Solution 

Toner Low: Toner Low, Replace Soon The toner cartridge is low. Order a new toner cartridge. 

Toner Out: Replace Toner Cartridge The toner cartridge is empty. Open the front door and 
replace the toner cartridge. 

 
 

Recycling Supplies 

For more information on the Xerox® supplies recycling program, go to: www.xerox.com/gwa. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3610&PgName=recyclesupplies&Language=English�
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Managing the Printer 

This section includes: 
• Viewing the Firmware Version .................................................................................................................................... 90 
• Adjusting Paper Type ..................................................................................................................................................... 91 
• Adjusting the Transfer Unit ......................................................................................................................................... 91 
• Adjusting the Fuser ......................................................................................................................................................... 92 
• Adjusting the Density ..................................................................................................................................................... 92 
• Printing Charts .................................................................................................................................................................. 93 
• Cleaning the Developer ................................................................................................................................................. 93 
• Cleaning the Transfer Unit ........................................................................................................................................... 94 
• Resetting Defaults ........................................................................................................................................................... 94 
• Initializing the Print Meter............................................................................................................................................ 95 
• Resetting the Transfer Unit .......................................................................................................................................... 95 
• Resetting the Fuser .......................................................................................................................................................... 95 
• Clearing Job History ........................................................................................................................................................ 96 
• Clearing Storage ............................................................................................................................................................... 96 
• Clearing Device Memory ............................................................................................................................................... 97 
• Adjusting the Altitude .................................................................................................................................................... 97 
• Decreasing Electrostatic Memory .............................................................................................................................. 98 
• Enabling Ghost Control .................................................................................................................................................. 98 

The Service Tools menu contains tools to use for general maintenance and for troubleshooting your 
printer. Some service tools are designed for use by, or under the guidance of, a trained service 
representative. 
 
 

Viewing the Firmware Version 

To view the firmware version on the control panel: 
1. At the printer control panel, press the Menu button. 

Note: To navigate through the menu, use the Up or Down arrow buttons. 

2. Navigate to Admin Settings, then press OK. 
3. Navigate to Service Tools, then press OK. 
4. Select F/W Version, then press OK. 
5. To return to the Ready screen, press the Menu button. 
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Adjusting Paper Type 

Use Adjust Paper Type to compensate for paper thickness within a paper type. If the printed image is 
too light, use a heavier setting for the paper you are using. If the printed image is mottled or 
blotchy-looking, decrease the setting for the paper you are using. 

To adjust the paper type: 
1. At the printer control panel, press the Menu button. 

Note: To navigate through the menu, use the Up or Down arrow buttons. 

2. Navigate to Admin Settings, then press OK. 
3. Navigate to Service Tools, then press OK. 
4. Select Adjust Paper Type, then press OK. 
5. Select Plain, then press OK. 
6. Select Lightweight or Heavyweight, then press OK. 
7. To return to Service Tools, press the Back arrow button, or to return to the main menu, press the 

Menu button. 
 

Adjusting the Transfer Unit 

Adjusting the Transfer Unit can decrease a mottled appearance or white spots in your prints. This 
adjustment is available for each paper type. 

Note: This setting affects print quality. The higher the value, the darker the printed output appears. 

To adjust the transfer unit: 
1. At the printer control panel, press the Menu button. 

Note: To navigate through the menu, use the Up or Down arrow buttons. 

2. Navigate to Admin Settings, then press OK. 
3. Navigate to Service Tools, then press OK. 
4. Navigate to the paper type for the adjustment, then press OK. 
5. To increase or decrease the bias voltage, use the arrow buttons, then press OK. 
6. Repeat this procedure for each paper type you need to adjust. 
7. To return to Service Tools, press the Back arrow button, or to return to the main menu, press the 

Menu button. 
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Adjusting the Fuser 

Use Adjust Fuser for optimum print quality across a wide range of paper types. If the toner on a print is 
smearing or can be rubbed off the paper, increase the offset for the paper you are using. If the toner is 
blistered or mottled, decrease the offset for the paper you are using. 

To adjust the fuser: 
1. At the printer control panel, press the Menu button. 

Note: To navigate through the menu, use the Up or Down arrow buttons. 

2. Navigate to Admin Settings, then press OK. 
3. Navigate to Service Tools, then press OK. 
4. Select Adjust Fuser, then press OK. 
5. To select the paper type for the adjustment, press the arrow buttons, then press OK. 
6. To increase or decrease the amount of offset, press the arrow buttons, then press OK. 
7. Repeat this procedure for each paper type you need to adjust. 
8. To return to Service Tools, press the Back arrow button, or to return to the main menu, press the 

Menu button. 
 

Adjusting the Density 

The Density Adjustment feature controls how much toner is used to print. Adjust the density for lighter 
toner use for saving toner or heavier for making prints bolder. A positive adjustment makes the prints 
darker, while a negative adjustment makes the prints lighter.You can also adjust it to compensate for 
different paper types and thicknesses. 

To adjust the density: 
1. At the printer control panel, press the Menu button. 

Note: To navigate through the menu, use the Up or Down arrow buttons. 

2. Navigate to Admin Settings, then press OK. 
3. Navigate to Service Tools, then press OK. 
4. Select Adjust Density, then press OK. 
5. To increase or decrease the amount of offset, use the arrow buttons, then press OK. 
6. To return to the Ready screen, press the Menu button. 
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Printing Charts 

The Charts feature prints different charts that you can use to help diagnose printing issues. 

To print a chart: 
1. At the printer control panel, press the Menu button. 

Note: To navigate through the menu, use the Up or Down arrow buttons. 

2. Navigate to Admin Settings, then press OK. 
3. Navigate to Service Tools, then press OK. 
4. Navigate to Chart, then press OK. 
5. Select an option: 

− Pitch Chart: Prints a full page halftone chart and a pitch measuring chart that you can use as a 
ruler to measure the distance between repeating defects. To identify the component causing 
the defect, compare the halftone chart, or your print sample, against the measurements shown 
on the chart. 

− Full Page Solid: Prints a 1-sided or 2-sided solid black chart that you can use to observe density 
variations. 

− Alignment Chart: Prints an image alignment chart that you can use to check image alignment 
on the page. 

6. At the Are you sure? prompt, press Yes, then press OK. 
 

Cleaning the Developer 

The Clean Developer feature runs the developer motor and stirs the toner in the toner cartridge. Use 
Clean Developer to clean toner from a cartridge just before changing it or to refresh the toner after 
replacing a toner cartridge. 

To clean the developers: 
1. At the printer control panel, press the Menu button. 

Note: To navigate through the menu, use the Up or Down arrow buttons. 

2. Navigate to Admin Settings, then press OK. 
3. Navigate to Service Tools, then press OK. 
4. Navigate to Clean Developer, then press OK. 
5. At the Are you sure? prompt, press Yes, then press OK. 
6. The process runs automatically. Wait three minutes for the process to complete and the printer to 

return to Ready. 
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Cleaning the Transfer Unit 

The Clean Transfer Unit feature allows you to start motors that clean the bias transfer roller. You can use 
this feature if you observe toner on the back side of printed pages. 

To clean the transfer unit: 
1. At the printer control panel, press the Menu button. 

Note: To navigate through the menu, use the Up or Down arrow buttons. 

2. Navigate to Admin Settings, then press OK. 
3. Navigate to Service Tools, then press OK. 
4. Navigate to Clean Trans Unit, then press OK. 
5. At the Are you sure? prompt, press Yes, then press OK. 

After the process completes, the printer to returns to Ready. 
 

Resetting Defaults 

The Reset Defaults feature restores the system settings to the factory default settings. 
 

 CAUTION: Resetting NVM to the default erases all fax numbers, email addresses, and server 
addresses from the Address book. 

 

To reset defaults: 
1. At the printer control panel, press the Menu button. 

Note: To navigate through the menu, use the Up or Down arrow buttons. 

2. Navigate to Admin Settings, then press OK. 
3. Navigate to Service Tools, then press OK. 
4. Navigate to Reset Defaults, then press OK. 
5. At the Are you sure? prompt, press Yes, then press OK. 

After the process completes, the printer to returns to Ready. 
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Initializing the Print Meter 

The Initializing the Print Meter feature resets the print meter count to zero. 

To initialize the print meter: 
1. At the printer control panel, press the Menu button. 

Note: To navigate through the menu, use the Up or Down arrow buttons. 

2. Navigate to Admin Settings, then press OK. 
3. Navigate to Service Tools, then press OK. 
4. Navigate to Init Print Meter, then press OK. 
5. At the Are you sure? prompt, press Yes, then press OK. 

After the process completes, the printer to returns to Ready. 
 

Resetting the Transfer Unit 

The Reset Transfer Unit feature resets the life counter after you replace the transfer unit. 

To reset the transfer unit: 
1. At the printer control panel, press the Menu button. 

Note: To navigate through the menu, use the Up or Down arrow buttons. 

2. Navigate to Admin Settings, then press OK. 
3. Navigate to Service Tools, then press OK. 
4. Navigate to Reset Trans Unit, then press OK. 
5. At the Are you sure? prompt, press Yes, then press OK. 

After the process completes, the printer to returns to Ready. 
 

Resetting the Fuser 

The Reset Fuser feature allows you to reset the fuser life counter. Use this feature after you replace the 
fuser. 

To reset the fuser: 
1. At the printer control panel, press the Menu button. 

Note: To navigate through the menu, use the Up or Down arrow buttons. 

2. Navigate to Admin Settings, then press OK. 
3. Navigate to Service Tools, then press OK. 
4. Navigate to Reset Fuser, then press OK. 
5. At the Are you sure? prompt, press Yes, then press OK. 

After the process completes, the printer to returns to Ready. 
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Clearing Job History 

The Clear Job History feature erases the history of all finished jobs. 

To clear job history: 
1. At the printer control panel, press the Menu button. 

Note: To navigate through the menu, use the Up or Down arrow buttons. 

2. Navigate to Admin Settings, then press OK. 
3. Navigate to Service Tools, then press OK. 
4. Navigate to Clear Job History, then press OK. 
5. At the Are you sure? prompt, press Yes, then press OK. 

After the process completes, the printer to returns to Ready. 
 

Clearing Storage 

The Clear Storage feature erases all data stored in the RAM disk or optional Device Memory, including all 
files stored as secure prints or saved jobs. 

Note: This function is available only if RAM Disk is enabled or the Device Memory option is installed. 

To clear storage: 
1. At the printer control panel, press the Menu button. 

Note: To navigate through the menu, use the Up or Down arrow buttons. 

2. Navigate to Admin Settings, then press OK. 
3. Navigate to Service Tools, then press OK. 
4. Navigate to Clear Storage, then press OK. 
5. Select an option: 

− Clear All: Erases all Secure Print and Saved Job files. 
− Secure Document: Erases all Secure Print jobs. 
− Stored Document: Erases all Saved Job files. 

6. At the Are you sure? prompt, press Yes, then press OK. 
After the process completes, the printer to returns to Ready. 
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Clearing Device Memory 

The Clear Device Memory feature initializes the optional Device Memory. 

Note: This feature is available only when the optional Xerox Device Memory is installed. This feature 
is not compatible with generic memory devices. 

To clear device memory: 
1. At the printer control panel, press the Menu button. 

Note: To navigate through the menu, use the Up or Down arrow buttons. 

2. Navigate to Admin Settings, then press OK. 
3. Navigate to Service Tools, then press OK. 
4. Navigate to Clear Device Memory, then press OK. 
5. At the Are you sure? prompt, press Yes, then press OK. 

After the process completes, the printer to returns to Ready. 
 

Adjusting the Altitude 

Use Adjust Altitude to adjust the altitude to match that of the location where the printer is installed. If 
the altitude setting is incorrect, it can cause print-quality problems. 

To adjust the altitude: 
1. At the printer control panel, press the Menu button. 

Note: To navigate through the menu, use the Up or Down arrow buttons. 

2. Navigate to Admin Settings, then press OK. 
3. Navigate to Service Tools, then press OK. 
4. Select Adjust Altitude, then press OK. 
5. To select the altitude of the location of the printer, press the arrow buttons, then press OK. 
6. To return to Service Tools, press the Back arrow button, or to return to the main menu, press the 

Menu button. 
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Decreasing Electrostatic Memory 

The Decrease Electrostatic Memory feature reduces the instances of streaks along the edges of the 
printed output. 
 

 CAUTION: Use of this feature reduces print speed and the life of toner and drum cartridges. 
 

To enable Decrease Electrostatic Memory: 
1. At the printer control panel, press the Menu button. 

Note: To navigate through the menu, use the Up or Down arrow buttons. 

2. Navigate to Admin Settings, then press OK. 
3. Navigate to Service Tools, then press OK. 
4. Select Static Memory Ctr, then press OK. 
5. Select On, then press OK. 
6. To return to the Ready screen, press the Menu button. 
 

Enabling Ghost Control 

The Ghost Control feature reduces the instances of ghost images on the printed output. 

To enable Ghost Control: 
1. At the printer control panel, press the Menu button. 

Note: To navigate through the menu, use the Up or Down arrow buttons. 

2. Navigate to Admin Settings, then press OK. 
3. Navigate to Service Tools, then press OK. 
4. Select Ghost Control, then press OK. 
5. Select On, then press OK. 
6. To return to the Ready screen, press the Menu button. 
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Moving the Printer 

• Always turn off the printer and wait for the printer to shut down. 
• Disconnect the power cord from the back of the printer. 
• When lifting the printer, grasp the areas as shown. 
• Keep the printer level to avoid toner spillage. 
• Repack the printer and its options using the original packing material and boxes or a Xerox 

Repackaging Kit. 
 

 CAUTION: Failure to repackage the printer properly for shipment can result in damage not covered 
by the Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee. The Xerox® Warranty, 
Service Agreement, or Total Satisfaction Guarantee do not cover damage to the printer caused by 
improper moving. 

 

 
 

 CAUTION: The Xerox® Total Satisfaction Guarantee is available in the United States and Canada. 
Coverage could vary outside these areas. Please contact your Xerox representative for details. 
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General Troubleshooting 

This section includes: 
• Printer Does Not Turn On ............................................................................................................................................ 102 
• Printer Makes Unusual Noises ................................................................................................................................... 102 
• Printer Does Not Print ................................................................................................................................................... 103 
• Printer Resets or Turns Off Frequently ................................................................................................................... 104 
• Condensation Has Formed Inside the Printer ..................................................................................................... 104 

This section contains procedures to help you locate and resolve problems. Resolve some problems by 
simply restarting the printer. 
 
 

Printer Does Not Turn On 
 

Probable Causes Solutions 

The power switch is not turned on. Turn on the switch. 

The power cord is not correctly plugged into 
the outlet. 

Turn off the printer power switch, and plug the power cord securely 
into the outlet. 

Something is wrong with the outlet 
connected to the printer. 

• Plug another electrical appliance into the outlet and see if it 
operates properly. 

• Try a different outlet. 

The printer is connected to an outlet with a 
voltage or frequency that does not match the 
printer specifications. 

Use a power source with the specifications listed in the Electrical 
Specifications on page 130. 

 

 CAUTION: Plug the three-wire cord with grounding prong directly into a grounded AC outlet. 
 
 

Printer Makes Unusual Noises 
 

Probable Causes Solutions 

There is an obstruction or debris inside the 
printer. 

Turn off the printer and remove the obstruction or debris. If you 
cannot remove it, contact your Xerox representative. 

The Smart Kit Drum Cartridge is not fully 
seated. 

Remove and reseat the Smart Kit Drum Cartridge. 
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Printer Does Not Print 
 

Probable Causes Solutions 

The printer has an error. To clear the error, follow the onscreen prompts. If the error persists, 
contact your Xerox representative. 

The printer is out of paper. Load paper into the tray. 

A toner cartridge is empty. Replace the empty toner cartridge. 

The Error Indicator is blinking. • To clear the error, follow the onscreen prompts. 
• If the Ready Indicator is off, the printer has stopped working. 

Turn off the printer, then turn it on again. If the error persists, 
contact your Xerox representative. 

Both control panel indicators are off. Turn off the printer, confirm that the power cord is plugged in 
correctly to the printer and the outlet, then turn on the printer. If 
the error persists, contact your Xerox representative. 

The printer is busy. • If the Ready Indicator is flashing, it is normal. A previous print 
job could be the problem. Use the printer properties to delete all 
print jobs in the print queue. 

• Load the paper in the tray. 
• If the Ready Indicator is not flashing after you send a print job, 

check the Ethernet connection between the printer and the 
computer. 

• If the Ready Indicator is not flashing after you send a print job, 
check the USB connection between the printer and the 
computer. Turn off the printer, then turn it on again. 

The printer cable is disconnected. • If the Ready Indicator is not flashing after you send a print job, 
check the USB connection between the printer and the 
computer. 

• If the Ready Indicator is not flashing after you send a print job, 
check the Ethernet connection between the printer and the 
computer. 
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Printer Resets or Turns Off Frequently 
 

Probable Causes Solutions 

The power cord is not plugged into the outlet 
correctly. 

Turn off the printer, confirm that the power cord is plugged in 
correctly to the printer and the outlet, then turn on the printer. 

A system error occurred. Turn off the printer, then turn it on again. Print the Error History 
report from the Information Pages menu. If the error persists, 
contact your Xerox representative. 

The printer is connected to an uninterruptible 
power supply. 

Turn off the printer, then connect the power cord to a suitable 
outlet. 

The printer is connected to a power strip 
shared with other high-power devices. 

Plug the printer directly into the outlet or into a power strip that is 
not shared with other high-power devices. 

 
 

Condensation Has Formed Inside the Printer 

Moisture can condense inside a printer where the humidity is above 85% or when a cold printer is 
located in a warm room. Condensation can form in a printer after it has been sitting in a cold room that 
is heated quickly. 
 

Probable Causes Solutions 

The printer has been sitting in a cold room. • Allow the printer to acclimate for several hours before operation. 
• Allow the printer to operate for several hours at room 

temperature. 

The relative humidity of the room is too high. • Reduce the humidity in the room. 
• Move the printer to a location where the temperature and 

relative humidity are within the operating specifications. 
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Paper Jams 

This section includes: 
• Locating Paper Jams ..................................................................................................................................................... 105 
• Minimizing Paper Jams ................................................................................................................................................ 106 
• Clearing Paper Jams...................................................................................................................................................... 107 
• Troubleshooting Paper Jams ..................................................................................................................................... 113 
 
 

Locating Paper Jams 

 WARNING: Never touch a labeled area on or near the heat roller in the fuser. You can get burned. If 
a sheet of paper is wrapped around the heat roller, do not try to remove it immediately. Switch off 
the printer immediately and wait 20 minutes for the fuser to cool. Try to remove the jam after the 
printer has cooled. If the error persists, contact your Xerox representative. 

 

 CAUTION: Do not attempt to clear any paper jams using tools or instruments. This can permanently 
damage the printer. 

The following illustration shows where paper jams can occur along the paper path: 

 
 

1. Tray 2 
2. Rear Door 

3. Bypass Tray 
4. Tray 1 
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Minimizing Paper Jams 

The printer is designed to function with minimal paper jams using Xerox supported paper. Other paper 
types can cause jams. If supported paper is jamming frequently in one area, clean that area of the paper 
path. 

The following can cause paper jams: 
• Selecting the incorrect paper type in the print driver. 
• Using damaged paper. 
• Using unsupported paper. 
• Loading paper incorrectly. 
• Overfilling the tray. 
• Adjusting the paper guides improperly. 

Most jams can be prevented by following a simple set of rules: 
• Use only supported paper. For details, see Supported Paper on page 46. 
• Follow proper paper handling and loading techniques. 
• Always use clean, undamaged paper. 
• Avoid paper that is curled, torn, moist, creased, or folded. 
• To separate the sheets before loading into the tray, fan the paper. 
• Observe the paper tray fill line; never overfill the tray. 
• Adjust the paper guides in all trays after inserting the paper. A guide that is not properly adjusted 

can cause poor print quality, misfeeds, skewed prints, and printer damage. 
• After loading the trays, select the correct paper type and size on the control panel. 
• When printing, select the correct type and size in the print driver. 
• Store paper in a dry location. 
• Use only Xerox paper and transparencies designed for the printer. 

Avoid the following: 
• Polyester coated paper that is specially designed for inkjet printers. 
• Paper that is folded, wrinkled, or excessively curled. 
• Loading more than one type, size, or weight of paper in a tray at the same time. 
• Overfilling the trays. 
• Allowing the output tray to overfill. 

For a detailed list of supported paper, go to www.xerox.com/paper. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3610&PgName=rmlna&Language=English�


Troubleshooting 

 

 Xerox® Phaser® 3610 Black and White Printer 107 
 User Guide 
 

Clearing Paper Jams 

This section includes: 
• Clearing Paper Jams from the Front of the Printer ........................................................................................... 107 
• Clearing Paper Jams from the Back of the Printer ............................................................................................ 109 
 
 

Clearing Paper Jams from the Front of the Printer 
Note: To resolve the error displayed on the control panel you must clear all paper from the paper 
path. 

1. Remove any paper from the bypass tray. 

 
2. To remove the bypass tray from the printer, pull the tray straight out of the printer. Remove any 

remaining pieces of paper. 
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3. Remove Tray 1 from the printer. 

 
4. Remove any crumpled paper from the tray and any remaining paper jammed in the printer. 

 
5. Insert tray 1 into the printer, then push it in all the way. 

 
Note: If the tray is extended for legal size paper, the tray protrudes when it is inserted into the 
printer. 
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6. Insert the bypass tray back into the printer. 

 
7. To reset the interlock switch and clear the paper jam message, open and close the back door. 

  

 
 

Clearing Paper Jams from the Back of the Printer 
Note: To resolve the error displayed on the control panel you must clear all paper from the paper 
path. 

1. To open the lower rear door for an optional paper tray, pull it down from the top. 
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2. Remove any jammed paper from the back of the printer. 

 
3. To open the rear door, pull the release and lower the cover. 

 
4. If paper is jammed in the fuser, raise both green levers to open the fuser. 

 
5. To open the paper guide, raise the green handle. 
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6. Remove the paper as shown. 

 
7. Return the paper guide to its normal position. 

 
8. Lower the levers to their original position. 

 
9. Remove any jammed paper from the back of the printer. 
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10. Close the rear door. 

 
Note: The rear cover cannot close until both green levers are returned to their starting position, as 
instructed in step 8. 
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Troubleshooting Paper Jams 

This section includes: 
• Multiple Sheets Pulled Together .............................................................................................................................. 113 
• Paper Misfeeds ................................................................................................................................................................ 113 
• Label and Envelope Misfeeds .................................................................................................................................... 114 
• Paper Jam Message Stays On ................................................................................................................................... 114 
 
 

Multiple Sheets Pulled Together 
 

Probable Causes Solutions 

The paper tray is too full. Remove some of the paper. Do not load paper past fill line. 

The edges of the paper are not even. Remove the paper, align the edges, and then reload it. 

The paper is moist from humidity. Remove the paper from the tray, and replace it with new dry paper. 

Too much static electricity is present. • Try a new ream of paper. 
• Do not fan transparencies before loading in tray. 

Using unsupported paper. Use only Xerox approved paper. For details, see Supported Paper on 
page 46. 

Humidity is too high for coated paper. Feed paper one sheet at a time. 
  
 

Paper Misfeeds 
 

Probable Causes Solutions 

The paper is not correctly positioned in the 
tray. 

• Remove the misfed paper and reposition it properly in the tray. 
• Adjust the paper guides in the tray to match the size of the 

paper. 

The paper tray is too full. Remove some of the paper. Do not load paper past the fill line. 

The paper guides are not correctly adjusted 
to the paper size. 

Adjust the paper guides in the tray to match the size of the paper. 

The tray contains warped or wrinkled paper. Remove the paper, smooth it out, and reload it. If it still misfeeds, 
do not use that paper. 

The paper is moist from humidity. Remove the moist paper and replace it with new, dry paper. 

Using paper of the wrong size, thickness, or 
type. 

Use only Xerox approved paper. For details, see Supported Paper on 
page 46. 
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Label and Envelope Misfeeds 
 

Probable Causes Solutions 

The label sheet is facing the wrong way in the 
tray. 

• Load label sheets according to the instructions from the 
manufacturer. 

• Load labels in the tray, face up. 
For details, see Loading Labels in Trays 1-4 on page 66 or Loading 
Labels in the Bypass Tray on page 66. 

Labels are missing, curled, or pulled away 
from the backing sheet. 

Do not use any sheet where labels are missing, curled, or pulled 
away from the backing sheet. 

Envelopes are loaded incorrectly. Load envelopes in the bypass tray only. 
For details, see Loading Envelopes in the Bypass Tray on page 63. 

Envelopes are wrinkling. • The heat and pressure of the laser printing process can cause 
wrinkling. 

• Use supported envelopes. For details, see Guidelines for Printing 
Envelopes on page 62. 

 
 

Paper Jam Message Stays On 
 

Probable Causes Solutions 

Some paper remains jammed in the printer. Recheck the media path and ensure that you have removed all of 
the jammed paper. 

One of the printer doors is open. Check the doors on the printer and close any door that is open. 

The rear door interlock switch is not reset. To reset the interlock switch and clear the paper jam message, open 
and close the back door. 

Note: Check for, and remove, torn pieces of paper in the paper path. 
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Print-Quality Problems 

This section includes: 
• Controlling Print Quality .............................................................................................................................................. 115 
• Solving Print-Quality Problems .................................................................................................................................. 115 

Your printer is designed to produce consistently high-quality prints. If you observe print-quality problems, 
use the information in this section to troubleshoot the problem. For more information, go to 
www.xerox.com/office/3610support. 
 

 CAUTION: The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee does not 
cover damage caused by using unsupported paper or specialty media. The Xerox Total Satisfaction 
Guarantee is available in the United States and Canada. Coverage could vary outside these areas. 
Please contact your local representative for details. 

 

Note: To ensure print quality, the toner cartridge has been designed to cease functioning at a 
predetermined point. 

 

 
 

Controlling Print Quality 

Various factors can affect the quality of the output of your printer. For consistent and optimum print 
quality, use paper designed for your printer and set the paper type correctly. Follow the guidelines in this 
section to maintain optimum print quality from your printer. 

Temperature and humidity affect the quality of the printed output. The guaranteed range for optimal 
print quality is: 15–28ºC (59–82ºF) and 20–70% relative humidity. 
 

Solving Print-Quality Problems 

When the print quality is poor, select the closest symptom from the following table and see the 
corresponding solution to correct the problem. You can also print a Demo Page to more precisely 
determine the print-quality problem. 

If the print quality does not improve after carrying out the appropriate action, contact your Xerox 
representative. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=Phaser+3610&PgName=tech&Language=English�
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Symptom Solutions 

The output is too light. 

 

• To check the toner level, check the control panel, use the print driver, or 
CentreWare Internet Services. If the toner cartridge is near empty, 
replace it. 

• Verify that the toner cartridge is approved for use in this printer, and 
replace it as needed. For best results, use a genuine Xerox toner cartridge. 

• Replace the paper with a recommended size and type, and confirm that 
your printer and print driver settings are correct. 

• Verify that the paper is dry and that supported paper is used. If not, 
change the paper. 

• Change the Paper Type settings in the print driver. 
In the Printing Preferences of the print driver, on the Paper/Output tab, 
change the Paper Type setting. 

• Increase the Density Adjustment. For details, see Adjusting the Density 
on page 92. 

• If printer is located in a high altitude environment, adjust the altitude 
setting of the printer. For details, see Adjusting the Altitude on page 97. 

Toner smears or print comes off. 
The output has stains on the back 
side. 

 

• Change the Paper Type settings in the print driver. For example, change 
Plain to Lightweight Cardstock. 
In the Printing Preferences of the print driver, on the Paper/Output tab, 
change the Paper Type setting. 

• Verify that the paper is the correct size, type, and weight. If not, change 
the paper settings. 

• Adjust the fuser. For details, see Adjusting the Fuser on page 92. 
• Verify that the printer is plugged into an outlet that is providing the 

correct voltage and power. Review the electrical specification of the 
printer with an electrician if necessary. For details, see Electrical 
Specifications on page 130. 

Random spots on the output, or the 
image is blurry. 

 

• Ensure that the toner cartridge is installed correctly. 
• If you used a non-genuine brand toner cartridge, install a genuine Xerox 

toner cartridge. 
• Use the Rough paper type setting, or try a paper with a smoother surface. 
• Ensure that the humidity in the room is within specifications. For details, 

see Relative Humidity on page 129. 
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Symptom Solutions 

The output is blank. 

 

• Turn off the printer, then turn it on again. 
• If the error persists, contact your Xerox representative. 

Streaks appear in the output. 

 

• Replace the Smart Kit Drum Cartridge. 
• Contact your Xerox representative. 

The output has a mottled 
appearance. 

 

• Verify that the paper is the correct size, type, and weight. If not, change 
the paper settings. 

• Ensure that the humidity in the room is within specifications. For details, 
see Relative Humidity on page 129. 

• Set the Adjust Transfer Unit setting to a higher value for the paper type. 
For details, see Adjusting the Transfer Unit on page 91. 

Ghosting appears in the printed 
output. 

 

• Verify that the paper is the correct size, type, and weight. If not, change 
the paper settings. 

• Change the Paper Type settings in the print driver. 
In the Printing Preferences of the print driver, on the Paper/Output tab, 
change the Paper Type setting. 

• Replace the Smart Kit Drum Cartridge. 
• Adjust the fuser. For details, see Adjusting the Fuser on page 92. 
• Enable Ghost Control. For details, see Enabling Ghost Control on page 98. 
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Symptom Solutions 

The printed output is foggy. 

 

Clean the developer. For details, see Cleaning the Developer on page 93. 

Auger marks appear on the printed 
output. 

 

• To check the toner level, check the control panel, use the print driver, or 
CentreWare Internet Services. If the toner cartridge is near empty, 
replace it. 

• Verify that the toner cartridge is approved for use in this printer, and 
replace it as needed. For best results, use a genuine Xerox toner cartridge. 

• Clean the developer. For details, see Cleaning the Developer on page 93. 

The output print is wrinkled or 
stained. 

 

• Verify that the paper is the correct size, type, and weight for the printer 
and that it is loaded properly. If not, change the paper. 

• Try a new ream of paper. 
• Change the Paper Type settings in the print driver. 

In the Printing Preferences of the print driver, on the Paper/Output tab, 
change the Paper Type setting. 

Envelopes are wrinkled or creased 
when printed. 

Check if the crease is within 30 mm (1.2 in.) of the four edges of the 
envelope. 
• If yes, it is printing as expected. Your printer is not faulty. 
• If not, take the following actions: 

Ensure that envelopes are loaded properly in the bypass tray. For details, 
see Loading Envelopes in the Bypass Tray on page 63. 
Follow the guidelines for printing on envelopes. For details, see Guidelines 
for Printing Envelopes on page 62. 
If the problem persists, use a different size envelope. 
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Symptom Solutions 

The top margin is incorrect. 

 

• Ensure that the paper is loaded properly. 
• Ensure that the margins are set correctly in the application you are using. 

The printed surface of the paper is 
bumpy. 

 

1. Print a solid image over the entire surface of one sheet of paper. 
2. Load the printed sheet into the tray with the printed side face down. 
3. Print five blank pages to remove debris from the fuser rollers. 

The printed areas contain white 
spots. 

Adjust Transfer Unit to a lower value for the selected paper type. For details, 
see Adjusting the Transfer Unit on page 91. 

Toner streaks appear on the edges of 
prints. 

Enable the Decrease Electrostatic Memory feature. For details, see 
Decreasing Electrostatic Memory on page 98. 
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Getting Help 

This section includes: 
• Error and Status Messages ......................................................................................................................................... 120 
• Online Support Assistant ............................................................................................................................................. 120 
• Information Pages ......................................................................................................................................................... 120 
• More Information .......................................................................................................................................................... 121 

Your printer comes with utilities and resources to help you troubleshoot printing problems. 
 
 

Error and Status Messages 

The printer control panel provides information and troubleshooting help. When an error or warning 
condition occurs, the control panel informs you of the problem. Error messages warn you about printer 
conditions, such as low supplies or doors open, that require your attention. 
 

Online Support Assistant 

Online Support Assistant is a knowledge base that provides instructions and troubleshooting help to 
solve your printer problems. You can find solutions for print-quality problems, paper jams, software 
installation issues, and more. 

To access the Online Support Assistant, go to www.xerox.com/office/3610support. 
 

Information Pages 

Your printer has a printable set of information pages. These include configuration and font information, 
demonstration pages, and more. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=Phaser+3610&PgName=tech&Language=English�
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More Information 

You can obtain more information about your printer from these sources: 
 

Resource Location 

Installation Guide Packaged with the printer. 

Other documentation for your printer www.xerox.com/office/3610docs  

System Administrator Guide www.xerox.com/office/WC3615docs  

Recommended Media List United States: www.xerox.com/paper  
European Union: www.xerox.com/europaper  

Technical support information for your printer; 
including online technical support, Online Support 
Assistant, and driver downloads. 

www.xerox.com/office/3610support  

Information Pages Print from the control panel, or from CentreWare 
Internet Services, click Status > Information Pages. 

CentreWare Internet Services documentation In CentreWare Internet Services, click Help. 

Order supplies for your printer www.xerox.com/office/3610supplies  

A resource for tools and information, including 
interactive tutorials, printing templates, helpful tips, 
and customized features to meet your individual 
needs. 

www.xerox.com/office/businessresourcecenter  

Local sales and support center www.xerox.com/office/worldcontacts  

Printer registration www.xerox.com/office/register  

Xerox® Direct online store www.direct.xerox.com/  
 

 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=Phaser+3610&PgName=Man&Language=English�
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC3615&PgName=Man&Language=English�
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3610&PgName=rmlna&Language=English�
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3610&PgName=rmleu&Language=English�
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=Phaser+3610&PgName=tech&Language=English�
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3610&PgName=order&Language=English�
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&PgName=businessresourcecenter&Language=English�
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3610&PgName=customersupport&Language=English�
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3610&PgName=reg&Language=English�
http://www.direct.xerox.com/�
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Printer Configurations and Options 

Standard Features 

The Xerox® Phaser® 3610 Black and White Printer provides the following features: 
 

Feature Xerox® Phaser® 3610 Black and White Printer 

Print speed Standard mode up to 47 ppm for Letter and 45 ppm for A4 

2-Sided print speed Standard mode up to 28 ppm for Letter and 27 ppm for A4 

Print resolution 
• Standard print-quality mode 
• Enhanced print-quality mode 

 
• 600 x 600 dpi 
• 1200 x 1200 dpi 

Paper capacity 
• Bypass Tray 
• Tray 1 
• Optional 550-Sheet Feeder 

 
• 150 sheets 
• 550 sheets 
• 550 sheets 

Maximum print size Legal (216 x 356 mm, 8.5 x 14 in.) 

2-Sided Printing Up to 163 g/m² from any tray (Phaser 3610DN model only) 

Standard memory 512 MB 

Control panel Button-navigated menu with two-line display 

Connectivity • Universal Serial Bus (USB 2.0) 
• Ethernet 10/100/1000Base-T 
• Wireless network connectivity: Optional 

Remote access CentreWare Internet Services 
 
 

Available Configurations 

The Xerox® Phaser® 3610 Black and White Printer is available in two configurations: 
• Phaser 3610N: Network printer with USB and network connectivity. 
• Phaser 3610DN: Network printer with automatic 2-sided printing, and USB and network 

connectivity. 
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Options and Upgrades 
• Wireless network adapter 
• 550-Sheet Feeder with up to 3 additional trays 
• 512 MB RAM Memory 
• 4 GB Device Memory 
• Printer Stand 
 



Specifications 

 

126 Xerox® Phaser® 3610 Black and White Printer 
 User Guide 
 

Physical Specifications 

Weights and Dimensions 
 

 Phaser 3610DN Phaser 3610DN with Optional 
550-Sheet Feeder 

Width 39.4 cm (15.5 in.) 39.4 cm (15.5 in.) 

Depth 42.6 cm (16.8 in.) 42.6 cm (16.8 in.) 

Height 31.5 cm (12.4 in.) 41.0 cm (16.2 in.) 

Weight 13 kg (28.7 lb.) 16.1 kg (35.5 lb.) 
 
 

Standard Configuration 

 
 

Configuration with Optional 550-Sheet Feeder 
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Total Space Requirements 
 

 Phaser 3610DN Phaser 3610DN with Optional 
550-Sheet Feeder 

Width 59.4 cm (23.4 in.) 59.4 cm (23.4 in.) 

Depth 142.2 cm (56.0 in.) 142.2 cm (56.0 in.) 

Height 48.9 cm (19.3 in.) 58.4 cm (23.0 in.) 
 
 

Clearance Requirements 

Xerox® Phaser® 3610 Black and White Printer 

 
 



Specifications 

 

128 Xerox® Phaser® 3610 Black and White Printer 
 User Guide 
 

Clearance Requirements with Optional 550-Sheet Feeder 

Xerox® Phaser® 3610 Black and White Printer 
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Environmental Specifications 

Temperature 
• Operating temperature: 10–32°C (50–90°F) 
• Optimum temperature: 15–28°C (59–82°F) 
 

Relative Humidity 
• Minimum–Maximum Humidity Range: 10–85% 
• Optimal Humidity Range: 20–70% relative humidity at 28°C (82°F) 

Note: Under extreme environmental conditions, such as 10°C and 85% relative humidity, defects 
can occur due to condensation. 

 

Elevation 

For optimum performance, use the printer at elevations below 3100 m (10,170 ft.). 
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Electrical Specifications 

Power Supply Voltage and Frequency 
 

Power Supply Voltage Power Supply Frequency 

110–127 VAC +/-10%, (99–140 VAC) 50 Hz +/- 3 Hz 
60 Hz +/- 3 Hz 

220–240 VAC +/-10%, (198–264 VAC) 50 Hz +/- 3 Hz 
60 Hz +/- 3 Hz 

 
 

Power Consumption 
• Energy Saver Mode (Sleep): 2W 
• Ready, with fuser on: 52W 
• Continuous printing: 686W 

This printer does not consume electric power when the power switch is turned off even if the printer is 
connected to an AC outlet. 
 

ENERGY STAR Qualified Product 
 
 
 
 

 

The Xerox® Phaser® 3610 Black and White Printer is ENERGY STAR® qualified under the 
ENERGY STAR Program Requirements for Imaging Equipment. 

The ENERGY STAR and ENERGY STAR mark are registered United States trademarks. 

The ENERGY STAR Imaging Equipment Program is a team effort between United 
States, European Union, and Japanese governments and the office equipment industry 
to promote energy-efficient copiers, printers, fax, multifunction printers, personal 
computers, and monitors. Reducing product energy consumption helps combat smog, 
acid rain, and long-term changes to the climate by decreasing the emissions that result 
from generating electricity. 

Xerox® ENERGY STAR equipment is preset at the factory to switch to Energy Saver Modes after 10 
minutes from the last print. 
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Performance Specifications 
 

Feature Specifications 

Printer warm up time Power on: As fast as 12 seconds. 
Recovery from sleep mode: As fast as 3 seconds. 

Note: Warm up time assumes an ambient temperature of 20ºC (68°F) at 
60% relative humidity. 

 
 

Print Speed 

Maximum print speeds for 1-sided continuous printing are 47 ppm for Letter (8.5 x 11") and 45 ppm for 
A4 (210 x 297 mm). 

Several factors affect print speed: 
• 2-sided printing: The maximum print speeds for 2-sided continuous printing are 28 ppm for Letter 

(8.5 x 11") and 27 ppm for A4 (210 x 297 mm). 
• Print mode: Standard is the fastest print mode. Enhanced is half speed, or slower. 
• Paper size. Letter (8.5 x 11 in.) and A4 (210 x 297 mm) sizes share the fastest print speed. Larger 

sizes reduce print speeds. 
• Paper type: Plain prints faster than Rough Surface. 
• Paper weight: Lightweight prints faster than heavier paper, such as Cardstock and Labels. 
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Controller Specifications 

Memory 
 

Memory Xerox® Phaser® 3610 Black and 
White Printer 

Standard memory 512 MB RAM (optional 1024 MB 
total) 

Device Memory 4 GB Device Memory (optional) 

Flash memory 64 MB ROM 

EEPROM 48 KB EEPROM 
 
 

Interfaces 

Universal Serial Bus (USB 2.0) 

Ethernet 10/100/1000Base-TX 

IEEE802.11 Compliant Wireless Network Adapter (optional) 
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Basic Regulations 

Xerox has tested this printer to electromagnetic emission and immunity standards. These standards are 
designed to mitigate interference caused or received by this printer in a typical office environment. 
 

United States FCC Regulations 

This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against 
harmful interference when the equipment is operated in a commercial environment. This equipment 
generates, uses, and can radiate radio frequency energy. If it is not installed and used in accordance 
with these instructions, it may cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause harmful interference in which case the user will be 
required to correct the interference at his/her own expense. 

If this equipment does cause harmful interference to radio or television reception, which can be 
determined by turning the equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures: 
• Reorient or relocate the receiving antenna. 
• Increase the separation between the equipment and receiver. 
• Connect the equipment into an outlet on a circuit different from that to which the receiver is 

connected. 
• Consult the dealer or an experienced radio/TV technician for help. 

Changes or modifications to this equipment not approved by Xerox can void the authority of the user to 
operate this equipment. 
 

Note: To ensure compliance with Part 15 of the FCC rules, use shielded interface cables. 
 
 

Canada 

This Class A digital apparatus complies with Canadian ICES-003. 

Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada. 
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European Union 
 

 CAUTION: This is a Class A product. In a domestic environment, this product can cause radio 
interference in which case the user could be required to take adequate measures. 

 

The CE mark applied to this product symbolizes a declaration of conformity by Xerox with 
the following applicable Directives of the European Union as of the dates indicated: 
• December 12, 2006: Low Voltage Directive 2006/95/EC 
• December 15, 2004: Electromagnetic Compatibility Directive 2004/108/EC 

This printer, if used properly in accordance with the instructions, is not dangerous for the consumer or for 
the environment. 

To ensure compliance with European Union regulations, use shielded interface cables. 

A signed copy of the Declaration of Conformity for this printer can be obtained from Xerox. 
 

European Union Lot 4 Imaging Equipment Agreement Environmental 
Information 

Environmental Information Providing Environmental Solutions and Reducing Cost 

Introduction 

The following information has been developed to assist users and has been issued in relation to the 
European Union (EU) Energy Related Products Directive, specifically the Lot 4 study on Imaging 
Equipment. This requires manufacturers to improve environmental performance of in scope products 
and supports the EU action plan on energy efficiency. 

In scope products are Household and Office equipment that meet the following criteria. 
• Standard monochrome format products with a maximum speed less than 66 A4 images per minute 
• Standard color format products with a maximum speed less than 51 A4 images per minute 
 

Environmental Benefits of Duplex Printing 

Most Xerox products have duplex printing, also known as 2-sided printing, capability. This enables you to 
print on both sides of the paper automatically, and therefore helps to reduce the use of valuable 
resources by reducing your paper consumption. The Lot 4 Imaging Equipment agreement requires that 
on models greater than or equal to 40 ppm color or greater than or equal to 45 ppm monochrome the 
duplex function has been auto enabled, during the setup and driver installation. Some Xerox models 
below these speed bands may also be enabled with 2-sided printing settings defaulted on at the time of 
install. Continuing to use the duplex function will reduce the environmental impact of your work. 
However, should you require simplex/1-sided printing, you may change the print settings in the print 
driver. 
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Paper Types 

This product can be used to print on both recycled and virgin paper, approved to an environmental 
stewardship scheme, which complies with EN12281 or a similar quality standard. Lighter weight paper 
(60 g/m²), which contains less raw material and thus save resources per print, may be used in certain 
applications. We encourage you to check if this is suitable for your printing needs. 
 

ENERGY STAR 

The ENERGY STAR program is a voluntary scheme to promote the development and purchase of energy 
efficient models, which help to reduce environmental impact. Details on the ENERGY STAR program and 
models qualified to ENERGY STAR can be found at the following website: 
www.energystar.gov/index.cfm?fuseaction=find_a_product.showProductGroup&pgw_code=IEQ  
 

Power Consumption and Activation Time 

The amount of electricity a product consumes depends on the way the device is used. This product is 
designed and configured to enable you to reduce your electricity costs. After the last print it switches to 
Ready Mode. In this mode it can print again immediately if required. If the product is not used for a 
period of time, the device switches to a Power Saver Mode. In these modes, only essential functions 
remain active in order to enable reduced product power consumption. 

Upon exiting from Power Saver Mode, the first print will take slightly longer than in Ready Mode. This 
delay is the result of the system "waking up" from Power Saver mode and is typical of most imaging 
products on the market. 

If you wish to set a longer Activation Time or would like to completely deactivate the Power Save Mode, 
please consider that this device may then only switch to a lower energy level after a longer period of 
time or not at all. 

To learn more about Xerox participation in sustainability initiatives, please visit our website at: 
www.xerox.com/about-xerox/environment/enus.html  
 

Germany 

Blendschutz 

Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz 
vorgesehen. Um störende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt nicht 
im unmittelbaren Gesichtsfeld platziert werden. 
 

Lärmemission 

Maschinenlärminformations-Verordnung 3. GPSGV: Der höchste Schalldruckpegel beträgt 70 dB(A) oder 
weniger gemäß EN ISO 7779. 
 

http://www.energystar.gov/index.cfm?fuseaction=find_a_product.showProductGroup&pgw_code=IEQ�
http://www.xerox.com/about-xerox/environment/enus.html�
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Importeur 
Xerox GmbH 
Hellersbergstraße 2-4 
41460 Neuss 
Deutschland 

 

Turkey RoHS Regulation 

In compliance with Article 7 (d), we hereby certify “it is in compliance with the EEE regulation.” 

“EEE yönetmeliğine uygundur.” 
 

Regulatory Information for 2.4 GHz Wireless Network Adapter 

This product contains a 2.4 GHz Wireless LAN radio transmitter module which complies with the 
requirements specified in FCC Part 15, Industry Canada RSS-210 and European Council Directive 
99/5/EC. 

Operation of this device is subject to the following two conditions: (1) this device may not cause harmful 
interference, and (2) this device must accept any interference received, including interference that may 
cause undesired operation. 

Changes or modifications to this device not specifically approved by the Xerox Corporation may void the 
user's authority to operate this equipment. 
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Material Safety Data Sheets 

For Material Safety Data information regarding your printer, go to: 
• North America: www.xerox.com/msds  
• European Union: www.xerox.com/environment_europe  

For the Customer Support Center phone numbers, go to www.xerox.com/office/worldcontacts. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3610&PgName=msdsna&Language=English�
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3610&PgName=environmenteu&Language=English�
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3610&PgName=customersupport&Language=English�
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All Countries 

If you are managing the disposal of your Xerox product, please note that the printer may contain lead, 
mercury, perchlorate, and other materials whose disposal may be regulated due to environmental 
considerations. The presence of these materials is fully consistent with global regulations applicable at 
the time that the product was placed on the market. For recycling and disposal information, contact your 
local authorities. Perchlorate Material: This product may contain one or more Perchlorate-containing 
devices, such as batteries. Special handling may apply, please see 
www.dtsc.ca.gov/hazardouswaste/perchlorate. 
 

http://www.dtsc.ca.gov/hazardouswaste/perchlorate�
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North America 

Xerox operates an equipment take-back and reuse/recycle program. Contact your Xerox representative 
(1-800-ASK-XEROX) to determine if this Xerox product is part of the program. For more information 
about Xerox environmental programs, visit www.xerox.com/environment , or for recycling and disposal 
information, contact your local authorities. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3610&PgName=environmentna&Language=English�
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European Union 

Some equipment may be used in both a domestic/household and a professional/business application. 
 

Domestic/Household Environment 

 

Application of this symbol on your equipment is confirmation that you 
should not dispose of the equipment in the normal household waste 
stream. 

In accordance with European legislation, end of life electrical and electronic equipment subject to 
disposal must be segregated from household waste. 

Private households within EU member states may return used electrical and electronic equipment to 
designated collection facilities free of charge. Please contact your local disposal authority for 
information. 

In some member states, when you purchase new equipment, your local retailer may be required to take 
back your old equipment free of charge. Please ask your retailer for information. 
 

Professional/Business Environment 

 

Application of this symbol on your equipment is confirmation that you 
must dispose of this equipment in compliance with agreed national 
procedures. 

In accordance with European legislation, end of life electrical and electronic equipment subject to 
disposal must be managed within agreed procedures. 

Prior to disposal, please contact your local reseller or Xerox representative for end of life take-back 
information. 
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Collection and Disposal of Equipment and Batteries 

 

These symbols on the products and/or accompanying documents 
mean that used electrical and electronic products and batteries should 
not be mixed with general household waste. 

For proper treatment, recovery, and recycling of old products and used 
batteries, please take them to applicable collection points, in 
accordance with your national legislation and the Directive 
2002/96/EC and 2006/66/EC. 

By disposing of these products and batteries correctly, you will help to 
save valuable resources and prevent any potential negative effects on 
human health and the environment which could otherwise arise from 
inappropriate waste handling. 

For more information about collection and recycling of old products 
and batteries, please contact your local municipality, your waste 
disposal service or the point of sale where you purchased the items.  

Penalties may be applicable for incorrect disposal of this waste, in 
accordance with national legislation. 

 
 

Business Users in the European Union 

If you wish to discard electrical and electronic equipment, please contact your dealer or supplier for 
further information. 
 

Disposal Outside of the European Union 

These symbols are only valid in the European Union. If you wish to discard these items, please contact 
your local authorities or dealer and ask for the correct method of disposal. 
 

Battery Symbol Note 

Hg  

This wheeled bin symbol may be used in combination with a chemical 
symbol. This establishes compliance with the requirements set out by 
the Directive. 

 
 

Battery Removal 

Batteries should only be replaced by a MANUFACTURER-approved service facility. 
 



Recycling and Disposal 

 

144 Xerox® Phaser® 3610 Black and White Printer 
 User Guide 
 

Other Countries 

Please contact your local waste management authority to request disposal guidance. 
 


	Safety
	Electrical Safety
	General Guidelines
	Power Cord
	Emergency Turn Off
	Laser Safety

	Operational Safety
	Operational Guidelines
	Ozone Release
	Printer Location
	Printer Supplies

	Maintenance Safety
	Printer Symbols
	Environmental, Health, and Safety Contact Information

	Features
	Parts of the Printer
	Front View
	Rear View
	Internal Parts
	Control Panel

	Energy Saver Mode
	Exiting Energy Saver Mode

	Information Pages
	Configuration Report
	Printing a Configuration Report

	Administrative Features
	Finding the IP Address of the Printer
	CentreWare Internet Services
	Accessing CentreWare Internet Services

	Accessing the Printer
	Logging In
	Logging In to CentreWare Internet Services
	Logging In at the Control Panel


	Billing Meter

	More Information

	Installation and Setup
	Installation and Setup Overview
	Selecting a Location for the Printer
	Connecting the Printer
	Selecting a Connection Method
	Connecting to a Computer Using USB
	Connecting to a Wired Network
	Finding the IP Address of the Printer Using the Control Panel
	Connecting to a Wireless Network
	Installing the Wireless Network Adapter
	Removing the Wireless Network Adapter
	Resetting Wireless Settings


	Configuring Network Settings
	About TCP/IP and IP Addresses

	Configuring General Setup Using CentreWare Internet Services
	Viewing Printer Information
	Configuring System Settings
	Configuring Clock Settings
	Configuring Tray Settings

	Configuring General Setup Using the Control Panel
	Getting Information About the Printer
	Using the Power On Wizard

	Installing the Software
	Operating System Requirements
	Installing the Print Drivers for a Windows Network Printer
	Installing the Print Drivers for a Windows USB Printer
	Installing Print Drivers for Macintosh OS X Version 10.5 and Later
	Installing Drivers and Utilities for UNIX and Linux
	Other Drivers
	Installing the Printer as a Web Service on Devices


	Paper and Media
	Supported Paper
	Recommended Media
	Ordering Paper
	General Paper Loading Guidelines
	Paper That Can Damage Your Printer
	Paper Storage Guidelines
	Supported Paper Types and Weights
	Supported Standard Paper Sizes
	Supported Paper Types and Weights for Automatic 2-Sided Printing
	Supported Standard Paper Sizes for Automatic 2-Sided Printing
	Supported Custom Paper Sizes

	Loading Paper
	Loading Paper in the Bypass Tray
	Loading Small Paper Sizes in the Bypass Tray
	Configuring Trays 1–4 for the Paper Length
	Loading Paper in Trays 1–4
	Configuring Tray Behavior

	Printing on Special Paper
	Envelopes
	Guidelines for Printing Envelopes
	Loading Envelopes in the Bypass Tray

	Labels
	Loading Labels in the Bypass Tray
	Loading Labels in Trays 1-4
	Guidelines for Printing Labels



	Printing
	Printing Overview
	Selecting Printing Options
	Print Driver Help
	Windows Printing Options
	Setting Default Printing Options for Windows
	Selecting Printing Options for an Individual Job for Windows
	Saving a Set of Commonly Used Printing Options for Windows

	Macintosh Printing Options
	Selecting Printing Options for Macintosh
	Saving a Set of Commonly Used Printing Options for Macintosh


	Printing Features
	Printing on Both Sides of the Paper
	Printing a 2-Sided Document
	Setting Up 1-Sided Printing
	2-Sided Page Layout Options

	Orientation
	Selecting Paper Options for Printing
	Enabling Letterhead 2-Sided Mode
	Printing Multiple Pages to a Single Sheet
	Printing Booklets
	Print Quality
	Lightness
	Printing Watermarks
	Scaling
	Printing Mirror Images
	Printing Special Job Types
	Saved Job
	Secure Print


	Using Custom Paper Sizes
	Defining Custom Paper Sizes
	Creating and Saving Custom Paper Sizes
	Printing on Custom Paper Sizes
	Printing on Custom Paper Size Using Windows
	Printing on Custom Paper Size Using Macintosh



	Maintenance
	Cleaning the Printer
	General Precautions
	Cleaning the Exterior
	Cleaning the Interior

	Ordering Supplies
	Consumables
	Routine Maintenance Items
	When to Order Supplies
	Viewing Printer Supply Status
	Toner Cartridges
	General Precautions
	Replacing a Toner Cartridge

	Recycling Supplies

	Managing the Printer
	Viewing the Firmware Version
	Adjusting Paper Type
	Adjusting the Transfer Unit
	Adjusting the Fuser
	Adjusting the Density
	Printing Charts
	Cleaning the Developer
	Cleaning the Transfer Unit
	Resetting Defaults
	Initializing the Print Meter
	Resetting the Transfer Unit
	Resetting the Fuser
	Clearing Job History
	Clearing Storage
	Clearing Device Memory
	Adjusting the Altitude
	Decreasing Electrostatic Memory
	Enabling Ghost Control

	Moving the Printer

	Troubleshooting
	General Troubleshooting
	Printer Does Not Turn On
	Printer Makes Unusual Noises
	Printer Does Not Print
	Printer Resets or Turns Off Frequently
	Condensation Has Formed Inside the Printer

	Paper Jams
	Locating Paper Jams
	Minimizing Paper Jams
	Clearing Paper Jams
	Clearing Paper Jams from the Front of the Printer
	Clearing Paper Jams from the Back of the Printer

	Troubleshooting Paper Jams
	Multiple Sheets Pulled Together
	Paper Misfeeds
	Label and Envelope Misfeeds
	Paper Jam Message Stays On


	Print-Quality Problems
	Controlling Print Quality
	Solving Print-Quality Problems

	Getting Help
	Error and Status Messages
	Online Support Assistant
	Information Pages
	More Information


	Specifications
	Printer Configurations and Options
	Standard Features
	Available Configurations
	Options and Upgrades

	Physical Specifications
	Weights and Dimensions
	Standard Configuration
	Configuration with Optional 550-Sheet Feeder
	Total Space Requirements
	Clearance Requirements
	Clearance Requirements with Optional 550-Sheet Feeder

	Environmental Specifications
	Temperature
	Relative Humidity
	Elevation

	Electrical Specifications
	Power Supply Voltage and Frequency
	Power Consumption
	ENERGY STAR Qualified Product

	Performance Specifications
	Print Speed

	Controller Specifications
	Memory
	Interfaces


	Regulatory Information
	Basic Regulations
	United States FCC Regulations
	Canada
	European Union
	European Union Lot 4 Imaging Equipment Agreement Environmental Information
	Environmental Information Providing Environmental Solutions and Reducing Cost
	Introduction
	Environmental Benefits of Duplex Printing
	Paper Types
	ENERGY STAR
	Power Consumption and Activation Time


	Germany
	Blendschutz
	Lärmemission
	Importeur

	Turkey RoHS Regulation
	Regulatory Information for 2.4 GHz Wireless Network Adapter

	Material Safety Data Sheets

	Recycling and Disposal
	All Countries
	North America
	European Union
	Domestic/Household Environment
	Professional/Business Environment
	Collection and Disposal of Equipment and Batteries
	Business Users in the European Union
	Disposal Outside of the European Union

	Battery Symbol Note
	Battery Removal

	Other Countries




